Thermo Scientific™

Multidrop™ PicoIT Software

User Guide

Software version 3.4.0

Cat. no. 1509050  Rev. 1.0
About This User Guide

Warnings and other markings used in the documentation

The following symbols and markings appear in this user manual.

**Warning / Caution**  Risk of injury to the user. Risk of damage to the instrument, other equipment or loss of performance or function in a specific application.

**Note**  Marks a tip, important information that is useful in the optimum operation of the system, or an item of interest.

**Tip**  Gives a helpful hint for getting the most out of the software functionality.
Contents

About This User Guide ................................................................. 3

Chapter 1 Introduction to the Multidrop™ Pico dispenser ................. 9
  How the Multidrop Pico dispenser works ..................................... 9
  Advantages of the Multidrop Pico dispenser ............................... 9
  Multidrop Pico dispenser Advantages ....................................... 10

Chapter 2 Safety ........................................................................... 11
  General safety rules .................................................................. 11
  Personal protective equipment .................................................... 11
  Possible inhalation hazard ........................................................ 11
  Ergonomic safety ..................................................................... 12
  Additional assistance ................................................................ 12

Chapter 3 System specifications ................................................... 13
  Intended use ............................................................................ 13
  System requirements ............................................................... 13
  Compatible fluids ..................................................................... 13
  Additional specifications .......................................................... 13

Chapter 4 Multidrop PicoIT Software overview ............................... 14
  Loading an example protocol .................................................... 14
  Main Operating Window – Layout ............................................. 15

Chapter 5 Building a simple protocol ............................................. 18
  Creating a new protocol file ...................................................... 18
  Fluid list ................................................................................. 18
  Show more information ........................................................... 19
  Fluid dispense mode ............................................................... 19
  Adding a fluid ......................................................................... 19
  Editing fluids ......................................................................... 20
  Removing fluids ...................................................................... 22
  Rearranging fluids .................................................................. 22
  Creating diluted fluids ............................................................ 22
  Plate parameters ...................................................................... 23
  Well selection and de-selection ................................................ 23
  Selecting Wells via Rectangle ................................................... 23
  Row / Column selection .......................................................... 23
  Additional selection/de-selection .............................................. 24
  Basic Titration example .......................................................... 24
  Undo ...................................................................................... 25
  Saving the protocol file ............................................................ 26
Closing the application and saving your work.................................26

Chapter 6 Additional protocol features ..............................................27
Multi-plate protocols and plate navigation.................................27
  Zoom........................................................................27
Plate-associated information ..................................................27
  Don’t dispense a plate.....................................................29
Set Value..........................................................................29
Titration..............................................................................30
  Highest and lowest concentration.....................................30
  Highest concentration or lowest concentration.......................32
Targeted Titration ................................................................33
Fluid Shift or Extend ................................................................34
  Fluid Shift ......................................................................34
  Fluid Extend ....................................................................35
Normalize.............................................................................36
  Show Normalization.........................................................39
  Remove Normalization.....................................................39
  Select Normalization Group..............................................40
Randomize ..........................................................................40
  Show plate randomization..................................................41
  Remove plate randomization..............................................41
  Copy plate randomization..................................................42
  Paste plate randomization...................................................43
Copy & Paste basics ...............................................................43
  Copy/Cut & Paste Wells .......................................................43
  Copy & Paste All Wells.........................................................43
  Paste Special ..................................................................44
View .................................................................................45
Show ................................................................................45
  Show Normalization..........................................................46
  Show Randomized.............................................................46
  Show fluids ....................................................................46
Plate functions ......................................................................46
  Remove Plate.................................................................46
  Clear Plate..................................................................47
  Replicate Plate.................................................................47
Ribbon – Advanced tab ...........................................................47
  Copy & Paste Fluids from the Fluid List...............................47
  Lock and Unlock Wells.......................................................48
Plate Move ..........................................................................48
Utilities ..............................................................................48
Ribbon – Current Protocol tab..................................................48
  Concentration and Volume Units ........................................48
  Shake during dispense.........................................................49
  Shake after each dispensehead.............................................49

Chapter 7 Special features ...............................................................51
Synergy.................................................................................51
Type page .................................................................................................................. 52
Plate page .................................................................................................................. 53
Titration page – A*B*C type ...................................................................................... 54
Layout page ............................................................................................................... 57
Summary page .......................................................................................................... 58
Quick plate ................................................................................................................ 59
Plate page .................................................................................................................. 59
Fluid & Titration page ............................................................................................... 61
Layout page ............................................................................................................... 62
Summary page .......................................................................................................... 64
Quick Plate examples ............................................................................................... 65
Enzyme Profile ......................................................................................................... 71
Plate page .................................................................................................................. 72
Fluids page ............................................................................................................... 73
Type page ................................................................................................................ 75
Titration page .......................................................................................................... 76
Layout page ............................................................................................................... 77
Summary page .......................................................................................................... 78
PCR .............................................................................................................................. 78
Plate page .................................................................................................................. 79
Fluids page ............................................................................................................... 81
Unknown Groups page ............................................................................................. 83
Standards / NTCs page .............................................................................................. 85
Layout page ............................................................................................................... 86
Summary page .......................................................................................................... 87
Manual PCR Specification ......................................................................................... 88

Chapter 8 Running a protocol ....................................................................................... 90
Run menu .................................................................................................................. 90
Initial display and dialog .......................................................................................... 90
Running a protocol on the Multidrop Pico dispenser .............................................. 92
Run complete .......................................................................................................... 92

Chapter 9 Settings ...................................................................................................... 93
Default values ......................................................................................................... 93
Display ..................................................................................................................... 95
Reports ....................................................................................................................... 96
Reports, continued ................................................................................................. 97
File locations .......................................................................................................... 98
Run ............................................................................................................................ 98

Chapter 10 Appendix A - Reports ............................................................................... 99
Report file formats .................................................................................................. 99
Example (Excel Compatible XML) .......................................................................... 99
Summary ................................................................................................................ 100
Fluids ....................................................................................................................... 100
Plates ....................................................................................................................... 101
Chapter 1
Introduction to the Multidrop™ Pico dispenser

How the Multidrop Pico dispenser works

The Multidrop Pico dispenser provides fast and reliable dispensing performance across a large dynamic range, eliminating the need for slow, error-prone and wasteful serial dilutions. The Multidrop Pico dispenser also enables assay miniaturization through low-volume assay component addition.

The Multidrop Pico dispenser provides dispensing across a wide range of life science applications:

- Dose-response curves for small molecule and biological-based drug discovery research
- Drug-drug synergy experiments for drug discovery
- Low-volume assay component dispensing of a wide range of fluids into microplates
- Complex enzyme kinetic studies can be made simple using the Enzyme Profile function
- Microplate PCR setups are easily designed and dispensed using the PCR function
- DMPK standards

Using single-use Dispenseheads to help avoid the possibility of cross-contamination, the Multidrop Pico dispenser offers non-contact digital dispensing in the picoliter to microliter range. It combines walk up convenience, ready-to-run performance and flexible, intuitive experiment design Multidrop PicoIT software to increase research productivity, reliability of results and the speed of life science research.

Even the most complex experimental plate layouts, such as drug-drug interaction (synergy) studies, can be made simple. Titrating one drug down the plate while another is titrated orthogonally across the plate enables two or more drug doses to be independently generated in every well. In addition, plate layouts can be randomized to reduce the impact of edge effects, increasing the integrity of the experimental data. The Multidrop Pico dispenser offers a convenient solution to address the most challenging experiments.

Advantages of the Multidrop Pico dispenser

The Multidrop Pico dispenser adds breakthrough capability to life science research workflows by dispensing picoliter droplets directly into assay-ready plates.
Multidrop Pico dispenser Advantages

- **Elimination of Serial Dilution:** Directly and independently dispense doses in each well using the proper number of picoliter droplets. Use finely spaced sets of doses to improve dose response curve fits. Digitally randomize plate layouts to reduce edge effects and increase data integrity.

- **Resource Savings:** Save labor by eliminating serial dilutions. Save 90% of your precious compounds. Save numerous pipette tips and intermediate plates to reduce your waste stream. Avoid ergonomic injuries and rework associated with repetitive hand pipetting processes.

- **Ease of Use:** Enjoy a simple, intuitive user experience with quick do-it-yourself experiment design Multidrop PicoIT software. Boost productivity with walk-up, just-in-time bench top convenience. Avoid carry-over and washing with single use, non-contact dispensing supplies. Add all low-volume assay components with one system.
Chapter 2
Safety

The Multidrop Pico dispenser should be used in accordance with all applicable safety rules that are in effect in the lab in which it is installed. Usage of the Multidrop Pico dispenser should also follow common-sense safety guidelines for chemical, mechanical, and electrical safety.

**Note** If this unit requires servicing, or you are unsure about any aspect of operation or safety, contact the Service Help Desk. The contact information can be found in the Multidrop Pico dispenser Service and Support document.

**Caution** Do not remove any of the Multidrop Pico dispenser covers. Contact your local Thermo Fisher Scientific service representative if the Multidrop Pico dispenser is not working properly. Do not attempt to repair the Multidrop Pico dispenser yourself.

**General safety rules**

- Place the Multidrop Pico dispenser on a work surface that supports all four feet securely.
- Plug the Multidrop Pico dispenser into a standard, grounded, electrical outlet. Note the power requirement listed on the back label of the Multidrop Pico dispenser.
- Avoid the moving parts of the Multidrop Pico dispenser during operation.

**Personal protective equipment**

The Multidrop Pico dispenser dispenses chemicals normally used by your company. The same safety precautions and personal protective equipment (PPE) specified by your employer for fluid transfer operations, such as pipetting into bio-assay well plates, should be used when operating the Multidrop Pico dispenser and handling these materials.

**Possible inhalation hazard**

The Multidrop Pico dispenser was designed with chemical safety in mind; however, it does dispense picoliter droplets of fluid and generates a small amount, less than 1% by volume, of very small aerosol droplets that might not be trapped within the well plate that you are dispensing into. If the fluids are known or suspected to be an inhalation or contact hazard, consider using the Multidrop Pico dispenser in an exhausted enclosure such as a lab fume hood, or a Class 1 or 2 biosafety cabinet.
Ergonomic safety

The Multidrop Pico dispenser typically requires a single manual pipetting operation for each dispensed compound. In most situations, using the Multidrop Pico dispenser in the intended manner decreases the frequency of shoulder, arm, and wrist motions and so decreases the stress on these joints compared to traditional methods.

As with any work task, ergonomics are heavily influenced by workstation setup. To minimize ergonomic risks associated with the use of the Multidrop Pico dispenser, consider the following work area design ideas:

- Place the Multidrop Pico dispenser on a work bench at a height that allows for proper visual and physical access for operators. Having the Multidrop Pico dispenser too high can lead to greater shoulder elevation when pipetting into the dispensehead and having the Multidrop Pico dispenser too low can lead to increased neck and back flexion.
- If an operator cannot comfortably access the Multidrop Pico dispenser, consider moving the Multidrop Pico dispenser to a different bench height. Place the Multidrop Pico dispenser close to the front of the work surface to minimize the distance the operator must reach to pipette into the dispensehead.
- Place the pipette tip disposal receptacle close to the Multidrop Pico dispenser.
- Place the computer keyboard close to the Multidrop Pico dispenser to minimize reach distance.
- Adjust the computer monitor height and screen angle for good physical and visual access during Multidrop Pico dispenser operation.
- Perform data analysis at a separate ergonomically designed workstation whenever possible rather than at the Multidrop Pico dispenser computer.

Additional assistance

Contact the Service Help Desk for additional assistance. The contact information can be found in the Multidrop Pico dispenser Service and Support document.
Chapter 3
System specifications

Intended use

The Multidrop Pico dispenser and dispenseheads (Cassettes) are intended only for the following, wherein all three conditions must be met:

- Dispensing of DMSO solvent or water containing surfactant with or without small molecule compounds or biomolecule(s).
- For research use only.
- Single-usage (i.e., non-reusable) operation of a dispensehead.

In addition to the requirement of Intended Use, the products should not be used for any of the following: (a) applications in Bio Safety Level 3 or 4 (BSL-3 or-4), food, animal or human testing or therapeutic delivery (except solely for therapeutic delivery for in vitro research uses) (b) to dispense any of: cells or biofluids (unless otherwise specified on product packaging), bacteria, viruses, pathogens, contagions, infectious agents, potent toxins or oncogenes, radioactive substances; and (c) in uses that are unsafe, bypassing any Product safety features, and/or disobeying any safety instruction.

System requirements

- Microsoft Windows 7 or greater required; Windows 10 recommended.
- Microsoft .Net Framework 4.8 or greater required.
- 8 GB system RAM and 256 GB drive (minimum) recommended.
- Minimum screen resolution of 1280x720 pixels.

Compatible fluids

See Appendix E – Dispense Specifications for details of compatible fluids.

Additional specifications

See the Multidrop Pico dispenser Operating Manual for more system specifications.
Chapter 4
Multidrop PicoIT Software overview

The Thermo Scientific Multidrop PicoIT dispensing software lets you:

- Design and build protocols for dispensing fluids into well plates.
- Run the protocols on the Multidrop Pico dispenser to dispense fluids into well plates.

A protocol is a file which describes the concentrations or volumes to be dispensed by the Multidrop Pico dispenser. You create protocols with the tools and functions described in this manual.

The Main Operating Window is the first window displayed when you start the Multidrop PicoIT software. It gives you control over protocol design functionality. From the Main Operating Window, you create, set up, edit, and run your dispensing protocols.

A good way to become familiar with the Multidrop PicoIT software is to load a sample protocol. Experiment with the features and functionality discussed in this manual at your own pace. Try some or all of these with a focus on the functionality that will be most applicable to your work with the Multidrop Pico dispenser.

- Click the File drop-down in the upper left corner. Click Open to browse the default protocols folder and load the Example Protocol from your default protocols folder.

- Select the Example Protocol and then click Open.
- The Example Protocol is then loaded into the Main Operating Window.
**Tip** To open a copy of a protocol, use **Open Copy** from the File menu. A copy of the selected protocol will be opened, with a unique file name.

Below is an illustration of the main operating window with a loaded example protocol with the functional areas highlighted. Descriptions of the functional areas follow below.

1. **File Menu**: Allows you to perform file operations common to Windows-based Multidrop PicoIT software (New, Save, Open, Exit, etc.) and to adjust system-wide settings.

2. **Ribbon and Tabs**:

   The Main Operating Window **ribbon**, located across the top of the window, organizes commonly-used tools and functions under three tabs. Access the **functions** associated with a tab by clicking one of the **tabs**:

   **Home**: This tab has most of the basic tools and functions necessary for building a protocol, including undo, copy and paste functions, plate viewing functions, and easy access to all the different ways to program the desired titrations.

   **Advanced**: The functions on this tab are related to manipulating the fluids table with copy and paste, well lock, manipulating well plates, and device utilities.

   **Current Protocol**: The functions on this tab are specific to the current protocol being worked on. This tab holds functions for setting the desired concentration or volume units, and specifying plate shaking parameters for mixing.
In all tabs, some functions may be “grayed-out” (unavailable) depending on the current items (wells, well plates, fluids, protocol) you are working on. This is the case for functions which require selection prior to performing the action. The tools and functions available on the tabs are detailed in subsequent chapters of this manual. Most ribbon functions can also be accessed from “right-click” contextual menus.

3. **Fluid List**: The Fluid List contains the fluids you have added to the protocol. The Fluid List indicates the fluid name and total volume of the fluid used in the entire protocol. Icons indicate whether the fluid is dispensed by concentration or volume and whether the fluid will be dispensed when the protocol is run. If the mouse is moved over a fluid, more information is displayed.

You can add to, change, or delete from this list (see Fluid list section for details).

4. **Normalization**: When a plate has been normalized (see Normalize section), this display is an indicator that a normalization scheme is part of this protocol.

When the mouse is moved over the icon, normalization information is displayed, including the volume of all normalization fluids used in the protocol and the desired dispense order for normalization fluids.

5. **Show**: The Plate View area of the Main Operating Window permits turning on or off viewing of normalization and randomization, if those have been applied to the current protocol. Additionally, moving the mouse over the icon allows you to filter the set of fluids displayed on the plate. See Show section for details.

6. **Plate Navigation**: The Plate Navigation area allows you add well plates to the current protocol and to navigate through each of the well plates in a multi-plate protocol. This area also allows you to zoom in or out of the well plate grid. See Multi-plate protocols and plate navigation section for details.

7. **Well plate grid**:

The Main Operating Window contains graphical depictions of the well plates in the current protocol. Each gridded area represents a single well plate, and each square represents a well. The grid has well rows alphabetized on the Y-axis and well columns numbered along the X-axis. The Multidrop PicoIT software identifies wells in each plate by a row-column designation – A21, B14, C16, etc.

Information about each plate is displayed just above each plate graphic. You can change the plate settings by double-clicking the information area or selecting Edit Plate from the right-click context.
menu. A “Don’t dispense” checkbox is used to skip a plate during a protocol run. See Plate-associated information section for details.

The well plate receives the fluids that are dispensed by the Multidrop Pico dispenser. Based on the currently-loaded protocol, each well is color-coded to indicate the fluid(s), as well as their respective concentration or volume – as indicated by the color saturation – in that well.

When you move your pointing device over a well, information about the content of that well is displayed, including the concentration and volume of each fluid to be added to the well, and including normalization fluids if applicable.

Since fluid is dispensed in increments of dispensehead drops, for low volumes the well content information will display both requested and dispensed concentrations and volumes. The first concentration/volume is the requested concentration or volume. The actual concentration and volume is shown in brackets.

See Appendix D – Concentration Calculations for more detail about concentration calculations.

Note In some instances, the concentration/volume you program into a well will not be in the range of the Multidrop Pico dispenser’s capability (see Appendix D – Concentration Calculations). In such cases, the well contents will display a warning message such as “Below minimum dispense volume.” Additionally, the report file will show only the concentration/volume actually dispensed.
Chapter 5
Building a simple protocol

Creating a new protocol file
You can create a new protocol in one of two ways:

Via the initial Main Operating Window
The following procedure will create a new protocol:

- Start the dispensing Multidrop PicoIT software.
- The initial, “empty” Main Operating Window is displayed.
- Work on that empty protocol, then save your work and name the protocol.

Via the File Menu
When the Multidrop PicoIT software is running, create a new protocol as follows:

- In the File Menu, click New.

A new protocol is created using the default protocol settings.

Fluid list
The Fluid List, located on the left side of the Main Operating Window, is the place to define all the fluids that can be used in a protocol. Each fluid must be given a unique name, and the fluid concentration (stock concentration) must be identified. Setting up the Fluid List is one of the first steps in creating a protocol.

In a new protocol, the Fluid List is empty. Note that you can copy a list of fluids from another protocol using the Copy & Paste Fluids from the Fluid List function discussed later in this manual. You can also build the Fluid List from scratch.
Show more information

For each fluid, information is displayed in the list, with more detail shown when the mouse is moved over a fluid. To show more information for each fluid, right-click on the list and select Show More from the menu. You can also change the default fluid view from the Display section of Settings.

Fluid dispense mode

Each fluid is specified to be dispensed by concentration or by volume.

When dispensed by Concentration, the Multidrop PicoIT software uses the fluid stock concentration and total well volume to calculate what volume of the fluid is needed to achieve the desired concentration. The Multidrop PicoIT software maintains the programmed concentration in the well if other parameters, such as assay volume or stock concentration, are changed.

When dispensed by Volume, the Multidrop PicoIT software maintains the programmed volume in the well if other parameters are changed. If the stock concentration of a fluid is unknown, it must be dispensed by volume; the stock concentration may be left unspecified. If you adjust the stock concentration of a fluid dispensed by volume, the resulting concentration in the programmed wells will be adjusted because the dispensed volume will be maintained.

Adding a fluid

The figure below shows an empty Fluid List. To add a fluid to the list, click the plus sign (+) to the right of the Fluids heading. Note that the fluid class, concentration, and dispense by concentration/volume default to the values specified in Settings. You can change the default settings.

A preliminary entry is created that can be used as is or modified if desired. To modify any of the parameters, move the mouse over the entry. When the Edit button appears, you can Edit the entry. You can also Edit the entry by double clicking.
An example Fluid List is shown below.

For each fluid, the name and total volume of the fluid used in the entire protocol is shown.

**Note** If the total dispense volume of a fluid exceeds the maximum dispense volume (see Appendix E – Dispense Specifications), the volume will be split between two or more dispenseheads.

Icons indicate whether the fluid is dispensed by concentration or volume and whether the fluid will be dispensed when the protocol is run. When the mouse is moved over a fluid the fluid class, stock concentration and other information are shown.

**Editing fluids**

Click to bring up the Fluid Edit dialog box. To edit a fluid, click on the fluid in the list.

You can also add a new fluid by clicking just as you can do from the main fluid list. Note that this method also copies the concentration, fluid class, dispense mode and source plate from the current fluid to the new fluid.
If desired, provide the fluid a different name and edit the stock concentration, dispense mode, or specify a different fluid class.

The fluid class is used to adjust dispense characteristics for different types of fluids. In addition to DMSO fluids, there are additional classes based on aqueous fluids. Refer to Appendix E – Dispense Specifications for fluid class details.

The button can be used to calculate a concentration, converting between units using molecular weight.

**Note** Concentration can be specified in molarity or mass/volume units, but well concentrations cannot be converted between unit types. If unit type is changed and the fluid is used in the protocol, well fluid dispense values are maintained (concentration or volume depending on the Fluid dispense mode).

You can also fill in any or all of the following optional information as desired. This information is used in the fluid list, and it will be included in the report file.

- Source plate
Building a simple protocol

Fluid list

- Source well
- The color used to identify the fluid in the protocol can be changed

If Dispense is set to No, you can associate the fluid with wells like the other fluids, but it will not be dispensed. This may be useful when you want a fluid to be used in Normalization calculations or to track controls that will be dispensed by a method other than with the Multidrop Pico dispenser.

If a fluid is changed, a Save button will appear. You will also be prompted to save when closing the dialog box or selecting a different fluid to edit.

**Small molecules**

For aqueous fluids with stock concentration specified in mass units, the small molecule option is displayed. For this purpose, small molecules are defined as molecules under 1000 Da.

If the source fluid is a small molecule, this option can be checked to prevent the system from applying biomolecule dispense limits based on stock concentration. See Dispensing Considerations for more information.

**Removing fluids**

Fluids can be removed from the protocol by selecting one or more fluids, and pressing the Remove Fluids button at the top of the list. The CTRL and SHIFT keys are used to select multiple fluids.

**Rearranging fluids**

Fluids can be moved up and down in the list using the arrow buttons that appear when the mouse is moved over a fluid.

The right-click context menu includes the option move a fluid to the top or bottom of the list.

**Creating diluted fluids**

Diluted versions of a fluid can be created using the Create diluted fluids button. Multiple dilutions can be created at the same time.

The new fluids will be inserted into the fluid list after the original fluid.
Building a simple protocol

Plate parameters

Note If a fluid is derived from another fluid using Creating diluted fluids or as the result of a Fluid Shift or Extend, some of the information cannot be edited and may change automatically when the source fluid is changed.

A new protocol is created with a single plate using Default values from Settings.

See the Plate-associated information section for details on how to change the plate type or other plate attributes. Additional volume must be set correctly; it is the volume added to each well of the plate not using the Multidrop Pico dispenser, and is used for concentration and normalization calculations (see Appendix D – Concentration Calculations).

Prior to using well tools and functions, wells must be selected in the well plate grid.

Selecting Wells via Rectangle

Select a large group of adjacent wells by dragging a rectangle.

- Move your pointing device to the desired area of the well plate grid.
- Click the left button once and keep it pressed, then drag over the target area. Wells will be highlighted as you drag.
- Once you release the left button all selected wells are shaded and outlined.

Row / Column selection

Entire rows or columns can be selected by clicking on a row or column header to start selection. Only rows or columns from a single plate may be selected until the mouse button is released.
Once wells have been highlighted as selected, hold down the CTRL key while clicking wells to:

- Add unselected wells by holding the CTRL key while clicking an unselected well.
- Remove wells from the selection by holding the CTRL key while clicking a selected well. To de-select all wells, just click outside the plate.

Fluids can be added to wells in three basic ways: as a fixed concentration or volume, as an evenly-spaced titration series, or as a targeted titration series.

The example in this section describes how to set up an evenly-spaced titration series consisting of 8-point triplicates using two different fluids.

- Select 24 wells in the well plate for titration of the first fluid.
- On the Home tab, select Titration. An editing panel is then displayed.

- Select a fluid from the drop-down.
- Specify titration using highest and lowest concentrations.
- Assign Highest concentration (or volume) parameter.
- Assign Lowest concentration (or volume) parameter.
Tip Use the **paste function** in the lower-right area of the panel to auto-fill the highest and lowest concentration with the valid range limits. The high value is determined from fluid concentration and DMSO limit or recommended maximum aqueous dispense volume. The low value is limited by minimum dispense volume.

- Change **Replicates per level** to 3, leave the distribution and titration pattern unchanged.
- Once you have completed your edits, click **Apply**. **Apply** applies the function without closing the dialog box. **OK** applies the function and closes the dialog box.
- Now, with the titration dialog box still open, select a new set of 24 wells into which to apply the second fluid.
- In the titration dialog box, select a different fluid from the dialog box and click **OK**. This will apply the second fluid to the wells with the same settings for concentration/volume as the first fluid.

The well plate grid now shows the fluids to be titrated in the selected wells of the well plate. If the titration pattern is not what was intended, or the concentration/volume needs to be adjusted, simply re-select the wells and enter the titration dialog box again, to over-write the wells with the new parameters.

Additional detail about titration can be found in the **Titration** section.

**Undo** To undo an action after you perform it, click the **Undo** icon in the Home tab of the ribbon or use the keyboard shortcut (ctrl-Z).
Saving the protocol file

Make sure you save your work during and after each protocol design session. On the File Menu, click **Save** at any time to save your work.

**Note** If you are saving a protocol for the first time, a browsing window will be displayed where you can name and relocate the file.

Closing the application and saving your work

In the Main Operating Window, clicking the X closes the current protocol and exits the program. If you modified the protocol and haven’t saved, you are asked if you want to save the modifications.

**Tip** Even if you have saved changes in one or more of the tools and functions described above, if you click **Don’t Save**, *all of your modifications to the protocol will be discarded.*
Chapter 6
Additional protocol features

The **Building a simple protocol** chapter detailed the basics of creating a protocol. This chapter discusses all the tools and functions you can use to build protocols.

| Plates + | ← | → | ⊕ | 1 of 4 |}

The **Plate Navigation** area of the Main Operating Window allows you to

- create a protocol with more than one plate,
- navigate through each of the plates in a multi-plate protocol, and
- zoom the well plate grid.

**To add a new, empty plate** to the current protocol, click the + sign. When you do this, the empty plate is displayed and becomes the one you are working on.

**Note** To minimize evaporation, it is recommended that protocols using aqueous fluid classes be limited to 1536 wells or four plates.

The **Plate N of X** label indicates the current plate number you are working on (N) and the number of plates in the protocol (X). To navigate through multiple plates in a protocol, use the back and forward arrows on either side of the label. The keys “Page Up” and “Page Down” can also be used to navigate plates.

If you are working on a multi-plate protocol, refer to this area to see which plate is the “current” plate (plate N of X).

**Zoom**

To zoom the well plate grid:

- Move the bar towards zoom out to see more real estate in the current plate and additional plates in the protocol.
- Move the bar towards zoom in to focus in on the plate wells.
- Alternately, you can click the icons to zoom in or out by a small amount. The mouse wheel can also be used to zoom in or out while holding the CTRL key.

**Plate-associated information**

Plate-associated information is displayed above each plate.
When the mouse is moved over the plate information, a menu bar is displayed.

This information can be changed by clicking on the menu bar, double-clicking the information area, or by selecting Edit Plate from the right-click context menu.

- Modify the Plate type via an updated choice from the drop-down menu.
  Note that the plates in a multi-plate protocol do not need to be of the same plate type, nor do they need to have the same additional volume or DMSO limits.

Change Additional volume via manual entry. Additional volume is the volume added to each well of the plate not using the Multidrop Pico dispenser, and is used for concentration and normalization calculations (see Appendix D – Concentration Calculations).

- Change DMSO limit via manual entry.
- You can Name the current plate. Use this name as your own reference to help you determine which plate to load during runtime.
- Check Don’t shake to keep this plate from shaking even when shaking is enabled for the protocol. Don’t shake is always set for 1536-well plates, and the setting cannot be changed.

The Plate Edit dialog box allows you to go directly to edit other plates without exiting by using the back and forward arrows (plate N of X indicates the current plate you are editing).
• You can also add a new plate directly from the dialog box by clicking . Note that this method also copies the edit plate type, additional volume, and DMSO limit to the new plate.

Saving/canceling your edits:

• To save your edits, click OK or move to another plate.
• To cancel your edits, click Cancel. Note that this will only cancel edits to the current plate, but it will not cancel saved changes to previously-edited plates. Once you click either of these options, the dialog box closes and you are brought back to the Main Operating Window.

Don’t dispense a plate

At the far right of the plate-associated information is a checkbox.

Check Don’t dispense to skip the current plate when running the protocol. Note that this setting is temporary; it is not saved with the protocol.

Set Value

If you want to add fluid to wells at a single concentration/volume, as opposed to as a titration series, use the Set Value function.

• Select the wells to which you wish to add the fluid.
• On the Home tab, select Set Value.

Select a fluid from the drop-down and specify the concentration or volume of the fluid depending on the dispense mode for the fluid. Ensure that the value is within the valid range. Note that the range minimum is a “hard” limit based on Multidrop Pico dispenser
Additional protocol features

Titration

drop size, but the upper limit is a suggestion to keep the DMSO limit or recommended maximum aqueous dispense volume from being exceeded.

Once you have updated the parameters, click **Apply** (applies the function) or **OK** (applies the function and closes the panel).

**Note** A diluted fluid may be suggested if the requested value with the stock fluid concentration would be significantly below the minimum dispense volume. See the **Fluid Shift or Extend** section for more information.

**Note** For the functions of: **Set Value, Titration, and Targeted Titration**:

After you click **Apply** or **OK**, if the fluid was previously assigned to any of the selected wells, you will receive a warning message to replace or cancel. If you choose to replace, the newly defined values will overwrite the previously values for that fluid in the selected wells. If different fluids were previously assigned to any of the selected wells, the new fluid will be added to, and not replace, the existing fluids.

This section describes how to set up an evenly-spaced titration series in more detail than the basic titration example section did.

- Select the wells in the plate for titration.
- On the Home tab, select **Titration**. An editing panel is then displayed.

Use this selection to specify both the high and low limits for the titration and let the Multidrop PicoIT software fill in the remaining points, equally spaced according to the selected distribution.
• Select a **Fluid** from the drop-down list.
• Assign the **Highest concentration** (or volume) parameter.
• Assign the **Lowest concentration** (or volume) parameter.

**Tip** Use the **paste function** in the lower-right area of the panel to auto-fill the highest and lowest concentration with the valid range limits. The high value is determined from fluid concentration and DMSO limit or recommended maximum aqueous dispense volume. The low value is limited by minimum dispense volume.

• Select the **Distribution** via the drop-down list - Logarithmic or Linear.
• Assign **Replicates** per level. Each titration level will be replicated the specified number of times. The number of selected wells must be a multiple of Replicates. For instance, if 12 wells are selected, 3 replicates will result in 4 levels.
• Select the **Titration pattern** from the drop-down menu. The graphics illustrate where the Highest and Lowest levels will be placed in the selected area as well as whether the titration is distributed by row or column.

Once you have completed your edits, click **Apply** (applies the function) or **OK** (applies the function and closes the panel).
Additional protocol features
Titration

Note: A fluid shift or extension may be suggested if the requested titration cannot be achieved with the stock fluid concentration specified. See the Fluid Shift or Extend section for more information.

Use this selection when you wish to specify either the highest or the lowest concentration and apply a specific distribution, such as a 1:4 dilution, to the remaining points.

- Select a Fluid from the drop-down list.
- Assign Highest concentration (or volume) parameter if you are using highest, or assign Lowest concentration (or volume) parameter if you are using lowest.
- Select the desired Distribution via the drop-down – 1/2 Log, 1/3 Log, 1/4 Log, 1:2, 1:3, 1:4, 1:N, or Linear. For 1:N, N is a numerical value greater than 1 (does not need to be an integer). For Linear, the value increment is also specified.
- Assign Replicates per level. Each titration level will be replicated the specified number of times. The number of selected wells must be a multiple of Replicates. For instance, if 12 wells are selected, 3 replicates will result in 4 levels.
- Select the Titration pattern from the drop-down menu. The graphics illustrate where the Highest and Lowest levels will be placed in the selected area as well as whether the titration is distributed by row or column.

Once you have completed your edits, click Apply (applies the function) or OK (applies the function and closes the panel).
In a targeted titration, the levels are not distributed evenly. The targeted titration includes a user-defined zone where the levels are densely spaced around a value of interest. Targeting the titration around an expected IC50 value, for instance, can improve the IC50 estimate or make the same quality of estimate with fewer wells.

Many of the fields required for Targeted Titration are the same as the fields for Titration. A targeted titration can only be programmed by specifying both the highest and lowest concentrations. The additional fields for targeted titration are related to specifying the target range.

- Assign the Target concentration value – This value will become the center of the densely spaced region and must lie within the Highest and Lowest concentrations. This value might be, for example, the expected IC50.
- Assign the number of wells in the Target region. These wells will lie on either side of the target concentration value.
- Assign the +/- Target range. This defines the concentration or volume range above and below the target value that will be covered by the specified number of wells.

When the panel contains sufficient information, the diagram will indicate how many wells are planned for each “tail” region above and
below the target region and will show where the target region falls within the overall titration. When calculating the targeted titration, the Multidrop PicoIT software will always apply one well to each end concentration (the highest and lowest) and then any wells remaining after being distributed to the target region will be evenly spaced within each tail region.

**Fluid Shift or Extend**

If the titration specified in Titration, Targeted Titration, Synergy, Quick Plate, Enzyme Profile or PCR would result in well volumes significantly below the minimum well dispense volume, a shifted or extended fluid will be suggested. The suggested fluid will be an integral dilution of the selected fluid: 1:2 through 1:9, 1:10 through 1:90, etc. and less than 1:10,000 dilution.

A diluted fluid may also be suggested from Set Value, PCR, etc. if the well volume of would be significantly below the minimum well dispense volume.

If the diluted fluid is accepted, a new fluid will be automatically added to the fluid list and the titration will be completed using that fluid. In this case, you must create a new stock fluid based on the original stock fluid, following the recommended dilution. For a 1:20 dilution, it is expected that you will add 1 part of the original fluid to 19 parts diluent, to create a 5% solution of the original stock fluid.

If the titration can be accomplished with one fluid spanning the full concentration range requested, you will be offered a Fluid Shift. If, however, the concentration range is greater than that which can be achieved with a single fluid, you will be offered a Fluid Extension and the titration will be comprised of both the original stock fluid and the diluted extended fluid.

If the diluted fluid is not accepted, the titration will be completed using the original stock fluid, and the wells that were requested with concentrations/volumes outside the accessible range will be flagged as being below the minimum dispense volume.

**Note** Diluted fluids are permanently associated with the original stock fluid. If the original fluid is modified (name, concentration, etc.) the diluted fluid will also be changed.

**Fluid Shift**

For example, if the following titration is specified:
You will be prompted to create a shifted fluid, diluted 1:20 (5%).

This creates a new fluid and the titration will use the new fluid.

**Fluid Extend**

If the limits of the titration are modified as shown:

The titration cannot be accomplished with a shifted fluid, and an extended fluid is offered.
Additional protocol features

**Normalize**

This creates a new fluid and the titration will use both the original and new fluids. If possible, the maximum DMSO % of the extended fluid will not exceed that of the original fluid in the titration. And, the maximum DMSO % of the extended fluid will never exceed that specified in the plate parameters.

For some assays, it may be advantageous to normalize the DMSO or aqueous surfactant content of the wells. Because of the digital nature of dispensing from the Multidrop Pico dispenser, without normalization, not all wells will contain the same DMSO or surfactant content. It may also be desired to normalize the total volume of all fluids in a well, regardless of fluid class.

It is typical for the DMSO content in dispensed wells to range from 0.00001%-1%. For many assays it is preferred to minimize the DMSO content, but for others, normalizing the DMSO content to the highest level or some intermediate level may be desired.

It may also be advantageous to normalize the dispensed surfactant content for certain assays.

**Tip** The dispense range for Normalization Fluid is specified in **Appendix E – Dispense Specifications**. Normalization cannot
dispense a quantity lower than 1nL per well. If normalizing a well requires dispensing less than 1nL of fluid, no fluid will be added to that well.

- Select the wells for to be normalized with a specific fluid class. Wells may be selected from multiple plates. Note that Normalize is not accessible unless you have selected wells.
- In the Home tab, select Normalize.
- To normalize a class of fluids, select one of the available normalization options via a radio button on the Normalize Fluid Class tab.

Select the fluid class to normalize from the list. A well can be included in multiple normalization groups, but there can be only one group for each fluid class.

![Normalize options](image)

**Normalize to highest class volume.** This will add normalization fluid to selected wells such that the normalization fluid + titration fluid volumes all equal the highest volume well in the selection. It will not add normalization fluid to the highest volume well.

**Normalize to specified volume.** This will add normalization fluid to selected wells so that the normalization fluid + titration fluid volume is equal to the specified volume, unless the titration fluid volume already equals or exceeds the specified volume, in which case no normalization fluid will be added.

**Normalize to specified % of total volume.** This will add normalization fluid to selected wells such that the normalization fluid + titration fluids all equal the specified % of total well volume. It will not add normalization fluid to wells that contain titration fluid equal to or in excess of the specified % of total volume.

*Note* If normalizing to % of total volume each well is normalized to the volume appropriate for the well. This includes additional volume that may be different for each plate in the normalization group.

- To normalize the total volume of a well – all fluids regardless of fluid class, and including Additional volume (see Plate-
Additional protocol features

Normalize

- **Normalized information** – select one of the normalization options via a radio button on the Normalize Total Volume tab. The fluid class to use for normalization must be selected. A well can be included in multiple normalization groups, but there can be only one group for each fluid class.

- **Normalize to highest fluid volume.** This will add normalization fluid to selected wells such that the normalization fluid + titration fluids + additional volume equals the highest total volume well in the selection. It will not add normalization fluid to the highest total volume well.

- **Normalize to specified volume.** This will add normalization fluid to selected wells so that the normalization fluid + titration fluids + additional volume is equal to the specified volume, unless the additional volume + titration fluid volumes already equals or exceeds the specified volume, in which case no normalization fluid will be added.

  - Click **Normalize** to normalize the selected wells in the protocol or **Cancel** to abort normalization.

  **Tip** Wells that are normalized together using the same options are referred to as a **normalization group**.

The normalized wells are subsequently displayed with a **black tick mark** in the lower-left corner of the well indicating well normalization.

When you move your pointing device over a normalized well, you see the “**Normalize**” tag in the displayed information:
The Normalization display, in the Main Operating Window below the Fluid list shows up if the plate has a normalization scheme. When the mouse is moved over the icon, the total normalization volume for each fluid class is displayed.

- Set the **Dispense order** for the normalization fluids. Normalization fluids can be dispensed strictly before or after the fluids or they can be dispensed with the fluids.

**Note** When dispensing a protocol using high-volume cassettes, the Dispense order may cause dispensing to alternate between cassette types.

- The **dispense icon** / allows you to not dispense all normalization fluids.

**Show Normalization**

See the **Show Normalization** section in **Show**.

**Remove Normalization**

Use this function to remove from the **selected wells** any normalization you previously set up. If there are no normalized wells in the selected wells, this function is grayed-out and not accessible.

- Select the wells from which you want to remove normalization.
- Click Remove Normalization. This function is also available from the right-click contextual menu.
A dialog box is then displayed, asking you for confirmation to remove all normalization from selected wells.

Click **Continue** to confirm the removal of normalization or **Cancel** to abort the function. If you cancel, the normalization is left in place (see below, left). If you give confirmation, the cells marked for normalization lose their tick marks, and the normalization is removed (see below, right).

This function shows you which wells are normalized together following the same options. For instance, if you used “normalize to highest fluid volume” this function will show you which wells are included in this calculation. This is important if you specify and then later wish to view multiple separate groups that are all normalizing to unique highest values.

- Select a well that is normalized.
- Click **Select Normalization Group**.
- If the well is included in multiple normalization groups (different fluid classes), indicate which group to select.

The wells that are normalized together become selected.
Once a plate has been configured, the wells can be reordered randomly on the plate. This is a useful way to minimize the impact of systematic assay effects on the output data.

**Note** Randomization is a “per plate” feature. It is not possible to create separately randomized regions within a single well plate. The selected wells on the plate will be randomized. If you later wish to add more randomized wells to the plate they will be added to the rest of the randomized wells and they will all be randomized together as one group.

- Select the wells desired for randomization.
- Click **Randomize** to randomize the selected wells.

The randomized wells are subsequently displayed with a white tick mark in the lower-right corner of the well indicating well randomization. In addition, when you move your pointing device over a randomized well, you see the “Randomized” tag in the displayed information:

**Show plate randomization**

See the **Show Randomized** section in **Show**. Note, if you are viewing randomization, some other functionality will be limited.

**Remove plate randomization**

For the current plate in a protocol, use this function to remove all randomization from the current plate. If there are no randomized wells in the current plate, this function is grayed-out and not accessible.

- Click **Remove Plate Randomization**.
Additional protocol features
Randomize

• A dialog box is then displayed, asking you for confirmation to remove the randomization scheme.

![Remove normalization dialog box]

Remove normalization
Remove all normalization from selection.
OK to continue?

• Click Remove to confirm the removal of the randomization scheme or Cancel to abort the function. If you give confirmation, the cells marked for randomization lose their tick marks, and the randomization scheme is removed.

![Copy plate randomization]

Copy plate randomization
Use this function to copy the randomization scheme from one plate to another within the same protocol. You can only copy randomization to plates with the same dimensions as the source plate.

• Click Copy Plate Randomization.

• A dialog box is then displayed, asking you for the source plate and the target plate(s). Use the drop-down menu to specify source and destination. Note that you have the option to copy the randomization scheme from the source plate to all similar plates in the protocol.

![Copy plate randomization dialog box]

• Click Copy to perform the copy or Cancel to abort it. If you perform the copy to All similar plates, all plates with the same dimensions as the source plate will now have the same randomization scheme. You can also copy to the Clipboard, and paste the randomization scheme to a plate in another protocol.
Additional protocol features
Copy & Paste basics

Paste plate randomization

Use this function to paste a plate randomization scheme that was copied to the Clipboard from another plate or protocol.

Copy & Paste basics

You can copy and paste wells to duplicate them within a plate or copy them to another plate. You can also copy and paste all wells to duplicate the well contents in the current protocol or move them to another protocol.

Note  Pasting wells overwrites any current information in the target wells or plates.

Copy/Cut & Paste Wells

- Select the desired well(s) on the plate, using the techniques discussed previously.
- Click Copy Wells or Cut Wells on the Home tab. “Cutting wells” makes the selected wells revert to empty.
- If the wells are being pasted into another plate, navigate to that plate to make it the current, target plate.
- Set the Paste target by clicking the upper-left-most well of the target area.
- Finally, click Paste to bring the copied wells into the target area. The pasted wells will overwrite, without warning, any other well contents. If there is not enough contiguous space in the target area, you will get a paste warning message about truncation; at that point, you can cancel the Paste or continue with the truncation.

Note  All fluids and normalization are included in copy, cut, and paste. When copying to an external application (e.g. Excel), however, normalization is not included.

Copy & Paste All Wells

This function can be used to copy all well fluid contents from one plate to another. The plate types do not need to be the same. If a less dense plate is copied to a higher density plate, all the wells will be copied. Conversely, if a higher density plate is copied to a lower density plate, the wells will be truncated, with a warning. When the contents of a
Additional protocol features
Copy & Paste basics

Plate are copied and pasted into another plate, all fluids and normalization are copied but randomization is not copied. Additionally, target plate parameters such as additional volume and DMSO limit, are not copied.

- Navigate to the plate that you want to copy.
- Click Copy All Wells.
- Navigate to the target plate. If you want to set up a new plate with an existing one as a source, click the + sign to create the new plate.
- Click Paste to paste the copied wells into the target plate.

If the target plate is not empty you will be warned before pasting. If you choose not to replace all fluids on the plate, the copied fluids will be added to existing plate fluids, unless the same fluid occurred in both the source and target plates, in which case that fluid will be replaced.

If there is a mismatch in the plate size being copied vs. the target plate, you will receive a warning message. At that point, you may cancel or continue the paste. The result may be that the wells all fit and become one quadrant of the new plate, or the wells will be truncated.

**Paste Special** Paste Special is similar to Paste, but with the option of mapping each fluid to a different fluid. You can also choose not to paste individual fluids, if you wish to leave selected wells of a specific fluid blank in the pasted region.
If the source wells include normalization, you can also choose to **Paste normalization**.

If the **Replace all fluids in the paste region** box is not checked, the pasted fluids will be added to fluids that already exist in the target plate, unless the same fluid occurred in both the source and target plates, in which case that fluid will be replaced.

It is optional to Transpose rows and columns. You cannot map fluids that have different unit types (molarity vs. mass/volume) or dispense modes (by concentration/volume).

This Home tab function is a complement to **Zoom**.

- Click **One Plate** to size and center the current plate in view.
- Click **All Plates** to bring all plates into view.

**Tip**  
Double-click a plate border to size and center that plate in view.

The **Show** area of the Main Operating Window allows you to filter what is displayed in the Well plate. Move the mouse over the icon to show the fluid filter selection list.
**Show Normalization**

If normalization is used in the protocol, the checkbox allows you to view or not view the normalization fluid in the well plate.

**Show Randomized**

If randomization is used in the protocol, the checkbox allows you to view or not view the plates randomized.

**Show fluids**

Click and select from the drop-down menu to indicate which fluids in the protocol’s fluid list should be displayed on the plate.

- All Fluids
- Dispensed Fluids
- Only the fluid selected from the list

**Plate functions**

**Remove Plate**

- Navigate to the plate that you want to remove.
- Click **Remove Plate** on the **Advanced** ribbon tab. A dialog box is displayed, asking you to confirm the removal or cancel it.

![Remove Plate dialog box]

- Click **Remove** to remove the current plate. Click **Cancel** to stop the removal.

**Removing multiple plates**

You can remove multiple plates by selecting them before clicking **Remove Plates**.

- The current plate is always selected.
- Plates are automatically selected as you select wells on a plate. You can see a plate is selected by looking at the plate number in the upper-left corner.

In the image above, plates 2 and 3 are selected.

- You can toggle plate selection for an individual plate by holding down the **Ctrl** key while clicking a plate corner or information area.
- You can select a range of plates from the current plate by holding down the **Shift** key while clicking a plate corner or information area.
Clear Plate

- Navigate to the plate from which you want to clear all fluids. You can select multiple plates in the same way as **Removing multiple plates**.
- Click **Clear Plate** on the **Advanced** ribbon tab. A dialog box is displayed, asking you to confirm the clear or cancel it.

![Clear Plate Dialog Box]

- Click **Clear** to clear the current plate of all fluids, turning it into an “empty” plate. Click **Cancel** to stop the clear. Note that clearing the plate does not remove fluids from the Fluids List.

Replicate Plate

This function is handy for an automatic, one-step creation of a new plate with the exact characteristics of the current plate, including Normalization and Randomization. In contrast, the **Copy & Paste All Wells** function described previously allows you to copy the well fluid contents from one plate to another plate without copying randomization and without constraints on the plate types.

- Navigate to the plate that you want to replicate.
- Click **Replicate Plate** on the **Advanced** ribbon tab. A new plate with the exact characteristics is then created and appended to the end of the plate series; the new plate becomes the current plate.

Ribbon – Advanced tab

The Advanced ribbon tab contains features in addition to the **Plate functions**.

Copy & Paste Fluids from the Fluid List

This function allows you to copy a Fluid List from one protocol to another or from a separate list of fluids, such as from a Microsoft Excel file (refer to **Appendix B – Moving Data between the Multidrop PicoIT software and other programs** for information about this function). This function is handy when you are creating a new protocol that is similar to an existing one, and you do not want to enter a new Fluid List from scratch.

- Open the source protocol, and click **Copy Fluids**. This copies the current Fluid List to the clipboard.
- Bring up the target protocol, and click **Paste Fluids**. This brings in the entire Fluid List from the source, modifying any changed parameters of existing fluids in the target protocol (matched by name) and appending new fluids to the Fluid List.
Additional protocol features
Ribbon – Current Protocol tab

- **Replace Fluids** will replace each existing fluid with pasted fluids in the order they occur. All fluid parameters are changed to match the source. This allows you to use the same protocol repeatedly, but with fluids of different properties (name, stock concentration, source location names). Certain fluid properties cannot be changed (unit type).

**Lock and Unlock Wells**
Selected wells can be locked to prevent inadvertent changes to well fluids. Locked wells show a lock icon and cannot be selected.

If a Paste operation would overwrite a locked well, an error is displayed.

**Plate Move**
Use the ribbon buttons to move the current plate relative to other plates in the protocol. These features are also available from the menu **Plate-associated information** bar.

**Utilities**
You must have a device connected to use these features.

- You can check the dispensehead(s) on a cassette by pressing the **Cassette Check** button. From the dialog box press **Check** to test a cassette and display results.
- **Set Device ID** allows you to give a unique name to the device which is included in reports run on that device.
- **A1 Alignment** is used to adjust the A1 position. Refer to the Multidrop Pico dispenser **Operating Manual** for more detail.

**Ribbon – Current Protocol tab**
The functions on this tab apply to the current protocol, and any changes are saved in the current protocol file.

**Concentration and Volume Units**
Well fluids are displayed using the specified units of concentration and volume.
Shake during dispense

**Tip** It is highly recommended to **shake during dispense** for cellular assays when dispensing DMSO, particularly for larger volumes, to prevent DMSO from sinking to the well bottom and creating a local excess of DMSO and compound.

To aid in mixing the dispensed fluids you can program the Multidrop Pico dispenser to shake the well plate while it is dispensing fluids. The Multidrop Pico dispenser shaking intensity parameters were optimized by plate type, and are not user selectable. The duration of the shaking for each dispense event depends on the amount of dispensing occurring; wells with large amounts of fluid will be shaken longer because it takes more time to dispense them. This type of shaking will occur for every well dispensed for all fluids, as long as the dispensed volume exceeds the programmed Volume Threshold. Manually enter a **Volume Threshold** (in nL) and check the **Shake during dispense** box. When dispensing DMSO onto plated cells, it is recommended that shake during dispensing is turned on for any volumes greater than 100nL.

**Note** Shake during dispense is automatically enabled when a low-density plate (48 wells or fewer) is created, however, it can be disabled.

**Note** Shaking is always disabled for 1536-well plates, regardless of the protocol setting.

Shake after each dispensehead

**Tip** If not mixing off-line after dispensing, in addition to **shake during dispense** it is also recommended to **shake after each dispensehead** on each plate for DMSO dispensing. Depending on the dispensed volumes, additional volume, and plate type you should determine the shake duration during assay development or by visually testing the mixing of dye/DMSO in your well plate. Shake after each dispensehead is not recommended when dispensing aqueous fluids.

To aid in mixing the dispensed fluids, you can program the Multidrop Pico dispenser to shake the well plate after each dispensehead has completed dispensing on the current plate. The shaking intensity parameters were optimized by plate type, and are not user selectable. Manually enter a shake **Duration** (in seconds) and check the Shake after each dispensehead box. The duration is typically 3 seconds for a 384-well plate or 20 seconds for a 24-well plate.
**Note**  Shaking is always disabled for 1536-well plates, regardless of the protocol setting.
Chapter 7
Special features

Synergy

The Synergy function allows you to create a plate design for a drug-drug interaction or synergy experiment where multiple compounds are placed in the same well for many wells in a set of orthogonal titration sequences. The Multidrop Pico dispenser makes it especially easy to create synergy sequences because of the non-contact digital dispensing. Each compound is added to every well independently, and multiple compounds can be added to the same wells with no additional user effort. Synergy wells can also be normalized and randomized, if desired.

On the Home Tab, click Synergy to create a synergy sequence. You then navigate and enter parameters in a series of pages to create the sequence. Once you have completed the procedure, a new plate or plates with the synergy layout is added to the protocol.

Note When using the Synergy function, it is not necessary to pre-select the wells to which you wish to apply fluids. The Synergy function automatically creates new plates with the programmed well content, and ignores any wells that you may have already selected in an existing plate.
There are two types of Synergy experiments available. The first type factors all of the fluids together. The second type of experiment factors a single fluid against a group of other fluids one at a time.

- Select the synergy experiment type.

Click **Next** to go onto the next step or **Cancel** to abort the in-process layout procedure.
Assign the **Plate type**, **Additional volume**, and **DMSO limit** in the fields provided at the top of the dialog box – the current plate’s parameters are the defaults.
Note  **DMSO limit** is only displayed when DMSO fluids are in the protocol.

- If desired, click **the row letter(s) and/or column number(s)** to select the rows and columns of wells that should be **excluded** from the synergy layout. In the figure below, the user excluded rows G through J from the layout. To de-select a row or column, just click the row letter or column number again. This can be used to leave rows or columns empty for use with controls.
- If rows or columns have been excluded, you have the option to keep the primary Synergy grid from crossing excluded wells (if possible).

Click **Next** to go onto the next step or **Cancel** to abort the in-process layout procedure.

**Titration page – A*B*C type**

The titration page is different depending on the type of synergy experiment selected on the Type page.

The first two synergy fluids will form the **primary synergy grid**. The first fluid will flow down the non-excluded rows and the second fluid will flow across the non-excluded columns. The number of available rows and columns is displayed for reference.

Use the plus button on the right edge to add additional fluids from the fluids list to the synergy.
For each synergy fluid, choose Titration, Targeted Titration, or Set Value.

- Specify the number of Titration levels via manual entry.
- Fill out all other fields according to instructions in the Titration, Targeted Titration, or Set Value sections.
- You can Include “0” value by clicking the check box.

Click Next to go onto the next step or Cancel to abort the in-process layout procedure.

Note  A fluid shift or extension may be suggested. See the Fluid Shift or Extend section for more information.


The titration page is different depending on the type of synergy experiment selected on the Type page.

The primary titration fluid is used for non-excluded rows of the synergy grid. A separate grid will be created for each secondary fluid. The secondary fluid will flow across non-excluded columns.

- Select the secondary fluid(s) to be used by clicking the checkbox next to the fluid name (below left). You can de-select an already-
selected fluid by re-clicking the checkbox to clear it. Additionally, you can select all fluids by clicking the Fluids checkbox at the top of the list.

Note You cannot select secondary fluids with different unit types (molarity vs. mass/volume) or dispense modes (by concentration/volume) for the same Synergy experiment.

For both the primary and secondary synergy fluids, choose Titration, Targeted Titration, or Set Concentration (or Volume).

- Specify the number of Titration levels via manual entry.
- Fill out all other fields according to instructions in the Titration, Targeted Titration, or Set Value sections.
- You can Include “0” value by clicking the check box.

Click Next to go onto the next step or Cancel to abort the in-process layout procedure.

Note A fluid shift or extension may be suggested. See the Fluid Shift or Extend section for more information.
Choose **how to arrange the synergy titrations** on the plate. Select a layout option by clicking the associated radio button(s):

- **Layout does not leave empty wells.** This option fills in all the wells along the columns, starting in A1, and does not leave empty rows or columns. It might not result in neatly ordered titration levels. Wells are filled by row or column as specified.

For the remaining options, titration levels of the first 2 fluids determine the number of rows and columns in the layout grid. They start by creating a primary synergy grid from the first two fluids, repeating that grid combined with the remaining fluids as needed.

- **Each plate contains a single grid.** Only a single synergy grid will be placed on each plate.
- **Each plate contains multiple grids.** If multiple copies of the primary synergy grid can be placed on a plate, they will be placed by row or column as specified.
- **Each plate contains multiple grids, with plate breaks.** Plate breaks will be made to keep titration sequences together. For example:
  - If 9 primary synergy grids fit on each plate.
  - If 3rd fluid has **5 levels** and 4th fluid has 3 levels, **5 grids** will be placed on each plate.
  - If 3rd fluid has **2 levels**, 4th fluid has **4 levels**, and 5th fluid has 3 levels, **8 grids** will be placed on each plate.

**Note** Not all of the layout options may be available, depending on the synergy Type, Titration options and Plate options.
In the final page you are given a summary of the number of wells and plates needed and an illustration of what the well contents in the Synergy plate(s) will look like. The mouse can be moved over individual wells to display contents.

**Normalize**

If you want to normalize all of the wells in the synergy experiment, click the Normalize wells button and specify the normalization (see Normalize).

**Randomize**

If you want to randomize all of the wells in the synergy experiment, click the Randomize each plate checkbox. Each plate will be randomized separately.

Click Finish to create the synergy titrations. Back and Cancel are also available.

Once you click Finish, the new Synergy plate (or plates) is added to the protocol and becomes the current plate.

**Note**  If a large number of plates will be created, a warning message is displayed.

Large number of plates
Synergy will create at least 17 384-well plates.

Continue?  

There is a maximum number of plates that can be created. The plate limit is different depending on the size of the plates.
The **Quick Plate** function allows you to create a group of identical titrations using multiple different fluids. This is useful when you want to make identical titrations with many fluids in the fluid list in only a few steps. The titrations can span multiple plates, but they must have the same concentrations and number of replicates.

On the Home Tab, click **Quick Plate**. Similar to **Synergy**, you then navigate and enter parameters in a series of dialog boxes to create the plates. Once you have completed the procedure, the new plates are added to the protocol.

**Note** When using the Quick Plate function, it is not necessary to pre-select the wells to which you wish to apply fluids. The Quick Plate function automatically creates new plates with the programmed well content, and it ignores any wells that you may have already selected in an existing plate.
• Assign the **Plate type**, **Additional volume**, and **DMSO limit** in the fields provided at the top of the dialog box – the current plate’s parameters are the defaults.

**Note**  **DMSO limit** is only displayed when DMSO fluids are in the protocol.

• If desired, click the **row letter(s) and/or column number(s)** to select the rows and columns of wells that should be excluded from the Quick Plate layout. In the figure above (right), the user excluded row D and columns 11 and 12 from the layout. To de-select a row or column, just click the row letter or column number again.

• If rows or columns have been excluded, you have the option of apply fluid Layout to each region separately. The default is to skip over excluded rows and columns during layout.

Click **Next** to go onto the next step or **Cancel** to abort the in-process layout procedure and discard all modifications.
• **Select the fluid(s)** to be used by clicking the checkbox next to the fluid name (below left). You can de-select an already-selected fluid by re-clicking the checkbox to clear it. Additionally, you can select **all fluids** by clicking the **Fluids** checkbox at the top of the list.

**Note** You cannot select fluids with different unit types (molarity vs. mass/volume) or dispense modes (by concentration/volume) for the same Quick Plate Titration.
To set up Quick Plate Titration, you must enter information similar to that needed for Titration or Targeted Titration:

- Specify the number of titration levels desired for each fluid.
- Choose Titration or Targeted titration and then follow the instructions in the **Titration** or **Targeted Titration** sections.

Once all parameters have been entered, click **Next** to go on to the next Quick Plate step. **Back** and **Cancel** are also available.

**Note** A fluid shift or extension may be suggested. See the **Fluid Shift** or **Extend** section for more information.

The Quick Plate Layout step allows you to decide how the titration series are laid out in the plate. You can arrange the titration points in many ways, including with the different fluids interleaved if desired. With your desired layout in mind, adjust the Quick Plate outcome by experimenting with various layout settings. As you change the primary layout settings, you can see the effects in the example layout options.

**Note** Several of the setting options will change based on previous selections.

- **Layout by rows**: The Well plate grid shows a layout with each fluid’s replicate levels progressing across a row.
- **Layout by columns**: The Well plate grid shows a layout with each fluid’s replicate levels progressing down a column.
Replicate layout

Choose to keep replicate levels together or not. Keeping replicate levels together will keep all the concentration replicates of each fluid together. Not keeping replicate levels together will instead keep the fluid’s titration series, of decreasing concentration, together. The remaining choices will adjust to the selection here.

Interleave fluids

- **Do not interleave**: The wells for each fluid are maintained together, according to the other layout selections.
- **Change fluid after each level replicate** (option available when keep replicate levels together is selected): After all the replicated for a given fluid level are applied, the next fluid will then be placed into the wells, until all of the fluids are placed. Then, the next set of level replicates for the first fluid will be applied, etc.
- **Change fluid after each singlicate** (option available when keep replicate levels together is not selected): All the titration levels for a single fluid are applied to the wells, then the titration levels of the next fluid are applied, until all the non-replicated fluid titration levels are applied. Then the replicates for all the fluids are applied in the same manner.
- **Change fluid after each well**: If replicate levels are kept together, this option places the first titration level of each fluid into the wells, changing fluid for every well. Then the replicates for all the fluids are applied in the same manner, followed by the other titration levels, until all the levels and replicates have been applied. However, if replicate levels are not being kept together, this option places the first titration level of each fluid into the wells, changing fluid for every well. Then it places the next titration level for each fluid in the same manner until all the singlicates for all the fluids have been placed. Then the replicates for all the fluids are applied in the same manner.

Example layout options

The final layout selection affects the flow of the layout. Example layouts are shown for each option. These options vary significantly based on previous selections. Move the mouse over an option to display a brief description of the layout behavior.

Once all parameters have been entered, click **Next** to go on to the next Quick Plate step. **Back** and **Cancel** are also available.
Click **Finish** to create the new plate(s). The new plate will then become the current plate. **Back** and **Cancel** are also available.

**Note**  If a large number of plates will be created, a warning message is displayed.

There is a maximum number of plates that can be created. The plate limit is different depending on the size of the plates.
In this section, several examples will be provided for Quick Plate layouts that increase in complexity. These examples are intended to provide initial guidance for how to use the different layout options in Quick Plate. They are not intended to be exhaustive, and it is recommended that users experiment with the various layout options to achieve the desired plate layout.

This example uses all the wells of the 96-well plate, with no columns or rows used for controls/left blank.

The titrations are laid out in columns, with the replicate series placed in adjacent columns.

The desired resulting plate is shown, along with the titration and layout page selections made to generate the plate.

In the Fluids & Titration page, select the fluids to apply to the newly created quick plates and specify the Titration or Targeted titration details, including number of levels, number of replicates, and concentration range and distribution.
In the Layout page, specify how to arrange the desired wells in the newly created plate/s. The example provides visual guidance regarding the impact of the different selections, but it does not represent the actual plate that will result. The resulting plate/s are shown after Next is clicked, at which point you may still click Back within the Quick Plate setup.
Example 2: Three 96-well plates with 10-point triplicates of six compounds, replicates in different plates

In the second example, more compounds are applied to multiple 96-well plates using the Quick Plate function. The six fluids are titrated as 10-point triplicates, with unused rows and columns at the plate edges. In this example, the replicates are applied to different plates, so the fluid singlicates are interleaved in the plate layout. Shown below are the desired plates and the Quick Plate pages used to generate them.

In the Plate page, select any rows and/or columns to exclude from the layout. In this case, the plate perimeter was excluded.

In the Fluids & titrations page, select the fluids to apply to the newly created quick plates and specify the Titration or Targeted titration details, including number of levels, number of replicates, and concentration range and distribution.
In the Layout page, specify how to arrange the desired wells in the newly created plate/s. For this example, to place the replicates into different plates, we select the option **interleave fluids – change fluid after each singlicate**.
Example 3: One 384-well plate with 10-point duplicates of 16 compounds, interleaved

In the third example, a plate with multiple fluids that alternate, or are interleaved, on a well-by-well basis will be created. This plate layout might be applicable if you need to match existing plates that have been generated by transferring wells from a 96-well to a 384-well plate. The two outermost columns on each side of the plate are excluded from this layout. The desired plate layout, using 16 fluids titrated in 10-point replicates, is shown, along with the titration and plate layout pages used to generate the plate.

In the Plate page, select the plate type and any rows and/or columns to exclude from the layout. In this case, a 384-well plate was selected and two columns at the left edge excluded.
In the Fluids & titrations page, select the fluids to apply to the newly created quick plates and specify the Titration or Targeted titration details, including number of levels, number of replicates, and concentration range and distribution.

In the Layout page, specify how to arrange the desired wells in the newly created plate/s. For this example, to achieve the desired layout, we have to lay out the fluids by columns and keep replicate levels together. Then, to achieve the interleaved pattern, we change fluid after each level replicate and keep the levels together, starting each level on a new column.
Enzyme Profile

The **Enzyme Profile** function allows you to automate the process of enzymatic assay development, validation, and generation of Michaelis-Menten kinetic analyses and Lineweaver-Burk plots (for example).

Once the enzymes, substrates/cofactors, and inhibitors are set up as fluids, you can design well layouts where enzymes, substrates/cofactors, or inhibitors are dispensed in constant (fixed) or variable (titrated) amounts. This makes it easy to determine the proper enzyme and substrate/cofactor concentrations, and inhibition mechanisms for enzymatic assays.

On the Home Tab, click **Enzyme Profile**. You then navigate and enter parameters in a series of dialog boxes to create the plates. Once you have completed the procedure, the new plates are added to the protocol.

**Note** When using the Enzyme Profile function, it is not necessary to pre-select the wells to which you wish to apply fluids. The Enzyme Profile function automatically creates new plates with the programmed well content, and it ignores any wells that you may have already selected in an existing plate.
• Assign the **Plate type**, **Additional volume**, and **DMSO limit** in the fields provided at the top of the dialog box – the current plate’s parameters are the defaults.

**Note**  
DMSO limit is only displayed when DMSO fluids are in the protocol.
• If desired, click the row letter(s) and/or column number(s) to select the rows and columns of wells that should be excluded from the Enzyme Profile layout. In the figure above (right), the user excluded columns 6 and 7 from the layout. To de-select a row or column, just click the row letter or column number again.
• If rows or columns have been excluded, you have the option of apply fluid Layout to each region separately. The default is to skip over excluded rows and columns during layout.

Click **Next** to go onto the next step or **Cancel** to abort the in-process layout procedure.
Select fluids to be used as enzymes, substrates/cofactors, and inhibitors.

- You must select one or two enzymes.
- You may select one or two substrates/cofactors, but you do not need to select any.
- You may select one or more inhibitors, but you do not need to select any. All inhibitors will be titrated using the same settings.

Click **Next** to go onto the next step or **Cancel** to abort the in-process layout procedure.

**Note** You cannot select fluids with different unit types (molarity vs. mass/volume) or dispense modes (by concentration/volume) in a list.
• Select one or two fluids for titration. Fluids not selected for titration will be dispensed at a fixed volume or concentration.
• If two fluids are selected for titration, you can also choose which fluid will be titrated down rows and which will be titrated across columns.
• Click **Next** to go onto the next step or **Cancel** to abort the in-process layout procedure.
For each titrated fluid, choose Titration, or Targeted Titration.

- Specify the number of Titration levels via manual entry.
- Fill out all other fields according to instructions in the Titration or Targeted Titration sections.
- You can Include “0” value by clicking the check box.
- Distribution is pre-selected as Linear or Logarithmic depending on the type of fluid, but you can change the selection.

If there are two titration fluids, they will form a titration grid, flowing down the non-excluded rows and across the non-excluded columns. The number of available rows and columns is displayed for reference.

- For each non-titrated fluid, specify a fixed volume or concentration.

Click Next to go onto the next step or Cancel to abort the in-process layout procedure.
Layout options will vary depending on the number of titrated and fixed fluids, plate settings, etc.

Select a primary layout option and then detailed options for that layout. In the example above, checking or clearing the “Allow multiple layout grids per plate” checkbox will change the example graphics and detailed options available.
**Summary page**

The Summary gives you an illustration of how the new plate will look. It also indicates the number of wells and plates involved in the scheme. The mouse can be moved over individual wells to display contents.

Click **Finish** to create the new plate(s). The new plate will then become the current plate. **Back** and **Cancel** are also available.

**Note** If a large number of plates will be created, a warning message is displayed.

There is a maximum number of plates that can be created. The plate limit is different depending on the size of the plates.

**PCR**

The PCR function allows you to automate the process of designing well plates for PCR experiments. This involves setting up dispense of master mixes, primers (also known as targets or probes) and samples (also known as templates) using the Multidrop Pico dispenser. Master mixes that are added using another dispense technology should be specified as “Additional Volume” on the Plate Page below.
Before using the PCR function, all fluids must be defined. If master mixes are premixed with primers, enter each mixture as a single fluid using one of the master mix fluid classes. Master mixes are set to dispense by volume.

After fluids to be dispensed are defined, protocols can be designed where all wells have the same master mix volumes. All master mixes will be dispensed in every well of the layout. For each primer/sample combination, the concentrations or volumes can be specified and the number of replicates. Optionally, standard curves and an NTC (no template control) region can be included; wells can be normalized to have the same total volume.

On the Home Tab, click **PCR**. You then navigate and enter parameters in a series of dialog boxes to create the plates. Once you have completed the procedure, the new plates are added to the protocol.

**Note** When using the PCR function, it is not necessary to pre-select the wells to which you wish to apply fluids. The PCR function automatically creates new plates with the programmed well content, and it ignores any wells that you may have already selected in an existing plate.

### Plate page

![Plate page screenshot](image)

**Plate page**
Special features

PCR

• Assign the **Plate type**, **Additional volume**, and **DMSO limit** in the fields provided at the top of the dialog box. The current plate’s type and DMSO limit will be the default choices, however, **additional volume** will always default to 0 (zero) for PCR, meaning that all well volume is added by the Multidrop Pico dispenser. As noted above, if master mix is to be dispensed by another method, specify that master mix volume in the additional volume field.

**Note**  DMSO limit is only displayed when DMSO fluids are in the protocol.

• If desired, click **the row letter(s) and/or column number(s)** to select the rows and columns of wells that should be **excluded** from the PCR layout. In the figure above (right), the user excluded column 12 from the layout. To de-select a row or column, just click the row letter or column number again.

Click **Next** to go onto the next step or **Cancel** to abort the in-process PCR layout procedure.
Fluids page

Categorization and attributes of fluids are shared by all plates in the protocol. Changes can be made from the PCR drop-down on the main ribbon. Master Mix is optional.

Assign PCR Fluids

- Master Mix
  - MM1
  - MM2
- Primers
  - Primer 1
  - Primer 2
  - Primer 3
- Samples / Standards
  - Sample 1
  - Sample 2
  - Sample 3
  - Sample 4

[OK] [Cancel]
In the Categorize PCR fluids tab, select **Master Mix**, **Primer**, and **Sample** fluids. Only fluids dispensed by volume are included in the Master Mix selection list.

- You must select at least one primer.
- You must select at least one sample.
- You do not need to select any master mixes if your primers include master mix or if master mixes will be dispensed by another method.
- You do not need to categorize all fluids.

In the Reporters and Biogroups tab, select **Reporter**, **Quencher**, and Optional **Biogroup**.

**Tip** If master mix is not to be dispensed by the Multidrop Pico dispenser, do not select any master mixes on the Fluids page, but include their volume as Additional Volume in the Plate tab (see Plate-associated information).

If protocol fluids have previously been assigned PCR tasks, a summary is displayed. Press **Assign PCR Fluids** to add or modify PCR fluid tasks.
Click **Next** to go onto the next step or **Cancel** to abort the in-process PCR layout procedure.

This dispense volume for each **Master Mix** is specified separately and will be dispensed in all Unknown, Standard, and NTC wells.

Multiple PCR Unknown groups can be specified. Use the plus + button on the right edge to add additional PCR groups.
For each PCR Unknown group:

- Specify the number of replicates that will be created for each primer/sample combination.
- All primers in the group share a single dispense value.
- All samples in the group share a single dispense value.
- Each sample will be dispensed separately with all primers in the group.

In this example, there are two Unknown groups. The first group uses 4 samples with 8 replicates, for a total of 32 wells with two multiplex primers in each well. The second group uses 2 samples with 6 replicates, for a total of 12 wells.

Click **Next** to go onto the next step or **Cancel** to abort the in-process PCR layout procedure.

**Note** You cannot select fluids with different unit types (molarity vs. mass/volume) or dispense modes (by concentration/volume) in a list (column).
Optional Standards and NTC (No Template Control) region can be specified.

Specify optional standards to be dispensed on one or all PCR plates.

- If **Standards** is not checked, no standards will be planned.
- Select one or more **primers** and specify the fixed dispense volume or concentration for the standard.
- Select one or more **samples** (standards) and specify the titration to use for each standard.
- The replicates setting in the titration panel will determine how many replicate standards are created for each primer/sample combination.
- Each **primer** will be combined separately with each **sample**. This is different from how the Unknown groups are planned where primers can be multiplexed.

Specify optional NTC (No Template Control) region.

- If **NTCs** is not checked, no NTCs will be planned.
- Specify the **replicates** to be used for each **primer**.
- Select one or more **primers** and specify the fixed dispense volume or concentration.
- Each **primer** is dispensed separately.

If **Standards/NTCs on each plate** is not checked, standards and NTCs will only be dispensed on the first PCR plate.

Click **Next** to go onto the next step or **Cancel** to abort the in-process PCR layout procedure.

**Note** You cannot select fluids with different unit types (molarity vs. mass/volume) or dispense modes (by concentration/volume) in a list (column).
If a Standards or NTCs were specified, there are additional layout options.

- Standards/NTCs can be located down the left and right edges or along the top and bottom edges of the plate.
- Standards can be condensed so the next replicate will occur immediately following the previous replicate even if that results in curves being broken across columns or rows. The NTC region is always condensed.

Changing the columns/combination setting will cause the PCR regions to change shape in the layout.

Since all replicated combinations will be planned on the same plate, multiple plates may be required for all of the primer/sample combinations.

You can also create a layout that does not leave any empty wells by selecting the checkbox at the top of the page.

Click Next to go onto the next step or Cancel to abort the in-process PCR layout procedure.
**Summary page**

The Summary gives you an illustration of how the new plate will look. It also indicates the number of wells and plates involved in the scheme.

The mouse can be moved over individual wells to display contents. Unknown groups, Standard, and NTC areas are indicated below.

It is optional to **Normalize** PCR wells. It may be desirable to normalize to a constant total assay volume if samples are different concentrations. This would typically be accomplished by normalizing with water and surfactant using an aqueous fluid class.

Click **Finish** to create the new plate(s). The new plate will then become the current plate. **Back** and **Cancel** are also available.

Well tooltips show PCR information for all PCR fluids (Master Mix, Primer, and Sample) and wells (Unknown, Standard, and NTC).
It is possible to specify PCR information outside of the automated process. It may be that you need to create Standards with specific values that are simple to create manually, or to use multiplexed primers for Standards or NTCs. The automated PCR process could continue to be used to create the Unknown groups.

PCR Fluid and Task assignments can be made from the PCR ribbon drop-down menu. Task assignments can also be made from the right-click well menu.
To assign a group of wells to a PCR task, select the wells and then select the task from the PCR menu. You can also remove any existing task assignments.
Chapter 8
Running a protocol

The Multidrop PicoIT software provides the environment for you to set up a protocol and run that protocol. The run can be:

- an **actual** run with your system connected to a Multidrop Pico dispenser and requiring physical loading of plates and cassettes, or
- a simulated run that gives you a preview of how a protocol will play out, with all the features of an actual run.

**Park Plate Holder** will retract the plate holder.

**Always Simulate** will simulate protocol runs, even if a device is connected. When Always Simulate is active, the Run button changes to Simulate.

**Load** your protocol into the Main Operating Window. Then click the Run button on the Home Tab.

The Multidrop PicoIT software checks for a connection to a Multidrop Pico dispenser. If the Multidrop PicoIT software fails to detect a device, a dialog box is displayed, asking if you want to **Simulate** a run, **Retry** the connection for an actual run, or **Cancel** the run altogether.
Note To minimize evaporation, a protocol run dispensing aqueous fluid classes will be limited to 1536 wells or four plates.

Note To ensure optimum performance, it is recommended that all plates include a well with volume of 30nL or greater for each fluid. Refer to Appendix F – Best Practices for Dispensing for more information.

The initial Run Window is then displayed.

The left area indicates the number of fluids and dispenseheads that will be needed for the run. There is also a Start button to initiate the dispensing preparation and the subsequent run. Note that if the plate has normalized wells, the protocol calls for normalization fluids.

If high-volume dispenseheads are appropriate for this protocol, the number of dispenseheads will be listed for each cassette type. You can override the high-volume recommendation with the Use high-volume cassettes checkbox if you do not want to use high-volume cassettes. The default state of the checkbox is set in Run Settings.

If text is entered into the Report Notes area, those notes will be written to the report file created after the run. Notes can also be added for each fluid, by clicking the Fluid Notes button.

The total load volume for each fluid is listed in the right portion of the screen along with a display of the current shake parameters for wells and plates. Changing these parameters changes the protocol. From this area it is also possible to enter Settings and modify report options.
Running a protocol on the Multidrop Pico dispenser

Note  The protocol shake parameters are indicated, but individual plates may have Don’t Shake selected.

Click Start to move onto the next phase of the run.

Refer to the Multidrop Pico dispenser Operating Manual for detailed information about running a protocol on the Multidrop Pico dispenser.

If report settings are set to generate a report on every run, a message appears to let you know that the report is being generated. For information on what to look for in your report, see Appendix A - Reports.

If a report is not automatically saved, it can later be saved using Save Report from the Run menu.

Click Close to return to the Operating Window. Click Park plate holder and Close to retract the plate holder before closing. You can always retract the plate holder from the Run menu.
Chapter 9
Settings

In the Main Operating Window File Menu, click Settings to assign application-wide parameters and values.

- Each section is opened by clicking on the section title region. Some sections will scroll to access all settings.
- Edit the settings via specified drop-down menu choices, manual entry, check box/radio button, or browsing.
- Once you have updated the settings, click OK to save them or Cancel to ignore all changes made in the current Settings session.
- Note that you can override many application settings with protocol-specific settings described in previous chapters.

Default values

There are several values which are automatically filled in with defaults that may be changed. For instance, when you create a new protocol, the default settings are used. However, any of the values can be changed when you first set up a protocol or later in the protocol preparation process.
## Settings

### Default values

<table>
<thead>
<tr>
<th>Item</th>
<th>Measure</th>
<th>Choices</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default protocol values</td>
<td>Molarity concentration units for new protocols</td>
<td>Drop-down menu</td>
</tr>
<tr>
<td></td>
<td>Mass concentration units for new protocols</td>
<td>Drop-down menu</td>
</tr>
<tr>
<td></td>
<td>Volume units for new protocols</td>
<td>Drop-down menu</td>
</tr>
<tr>
<td></td>
<td>Enable shake during dispense</td>
<td>If checked, shake during dispense will be enabled</td>
</tr>
<tr>
<td></td>
<td>Volume threshold for shake during dispense</td>
<td>Manual entry</td>
</tr>
<tr>
<td></td>
<td>Enable shake after each dispensehead</td>
<td>If checked, shake after each dispensehead will be enabled</td>
</tr>
<tr>
<td></td>
<td>Shake duration after each dispensehead</td>
<td>Manual entry</td>
</tr>
<tr>
<td>Default fluid values</td>
<td>Fluid class for new fluids</td>
<td>Drop-down menu</td>
</tr>
<tr>
<td></td>
<td>Concentration and units for new fluids</td>
<td>Manual entry and drop-down menu.</td>
</tr>
<tr>
<td></td>
<td>Dispense mode for new fluids</td>
<td>Toggle button</td>
</tr>
<tr>
<td>Default plate values</td>
<td>Plate type for new protocols</td>
<td>Drop-down menu</td>
</tr>
<tr>
<td></td>
<td>DMSO limit for new protocols</td>
<td>Manual entry</td>
</tr>
<tr>
<td>Normalization</td>
<td>Default dispense order</td>
<td>Drop-down menu</td>
</tr>
<tr>
<td>Additional volumes</td>
<td>Default additional volume for each plate type</td>
<td>Drop-down menu with manual entry.</td>
</tr>
</tbody>
</table>

*For each well plate type, you can assign a default additional volume.*
You can set up the default Multidrop PicoIT software parameters for how numbers, concentrations and volumes, will be displayed. Changing these settings does not impact how dispensing occurs, just how numbers are displayed.

<table>
<thead>
<tr>
<th>Item</th>
<th>Measure</th>
<th>Choices</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wells</td>
<td>Concentration significant digits (minimum)</td>
<td>Manual entry – 2 to 8</td>
</tr>
<tr>
<td></td>
<td>Volume significant digits (minimum)</td>
<td>Manual entry – 2 to 8</td>
</tr>
<tr>
<td>Fluids</td>
<td>Concentration decimal places</td>
<td>Manual entry – maximum of 4</td>
</tr>
<tr>
<td></td>
<td>Volume decimal places</td>
<td>Manual entry – maximum of 4</td>
</tr>
<tr>
<td></td>
<td>Show more information in fluid list</td>
<td>Check to show more fluid information in the fluid list on the main operating window.</td>
</tr>
</tbody>
</table>
Reports

The reports menu allows you to set system defaults for report generation.
### Reports, continued

<table>
<thead>
<tr>
<th>Item</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-save reports after protocol run</td>
<td>If the box is <strong>un-checked</strong>, reports must be manually saved after each protocol run (Save Report in Run menu). If the box is <strong>checked</strong>, you can set the auto-save report parameters and you will not be prompted for report save after each run.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>- Do not save aborted protocol runs: Check this box so that reports are not saved after an aborted run.</td>
<td></td>
</tr>
<tr>
<td>- Report name:</td>
<td></td>
</tr>
<tr>
<td>- Name is the protocol name combined with date and time. Click this to produce unique report names after each run.</td>
<td></td>
</tr>
<tr>
<td>- Fixed name. Selecting this option will give the same name to each protocol report. Manually enter the desired report filename. Select whether a new file is saved with an appended name – e.g., ReportName(1) or if older files are overwritten.</td>
<td></td>
</tr>
<tr>
<td>Report formats:</td>
<td></td>
</tr>
<tr>
<td>- Select one or more output formats.</td>
<td></td>
</tr>
<tr>
<td>Report options</td>
<td></td>
</tr>
<tr>
<td>- To round report data, click the Round to radio button and enter the number of significant digits.</td>
<td></td>
</tr>
<tr>
<td>- Check to include &quot;Don't Dispense&quot; fluid tables in reports.</td>
<td></td>
</tr>
<tr>
<td>- Check to include empty well lines in the “Tabular detail” table of reports.</td>
<td></td>
</tr>
<tr>
<td>- Check to include revision history in reports.</td>
<td></td>
</tr>
<tr>
<td>PDF report options</td>
<td></td>
</tr>
<tr>
<td>- PDF reports can be written for Letter or A4 page size.</td>
<td></td>
</tr>
<tr>
<td>- Check to include signature lines in PDF.</td>
<td></td>
</tr>
<tr>
<td>- Check to digitally sign reports using a certificate. If checked, you can select a certificate to use for signing.</td>
<td></td>
</tr>
</tbody>
</table>
**File locations**

The file locations menu allows you to set system defaults for protocol and report folders.

<table>
<thead>
<tr>
<th>Item</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Protocol folder</strong></td>
<td>Use the system-assigned default, or click the <strong>Browse</strong> button to search and assign the folder in which protocols are stored.</td>
</tr>
<tr>
<td><strong>Report folder</strong></td>
<td>Use the system-assigned default, or click the <strong>Browse</strong> button to search and assign the folder in which reports should be written.</td>
</tr>
</tbody>
</table>

**Run**

<table>
<thead>
<tr>
<th>Item</th>
<th>Choices</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default to use high-volume cassettes</td>
<td>The <strong>Use high-volume cassettes</strong> checkbox on the protocol Run screen will default to this setting.</td>
</tr>
<tr>
<td>Show “remove plate lid” reminder</td>
<td>If checked, a reminder will display each time a plate is loaded.</td>
</tr>
<tr>
<td>Require and validate plate ID</td>
<td>If checked, a plate ID is required and must be re-entered (and validated) each time the plate is loaded.</td>
</tr>
<tr>
<td>Do not show Help panel</td>
<td>If checked, the help panel will not be displayed.</td>
</tr>
</tbody>
</table>
Chapter 10
Appendix A - Reports

Report file formats
The Multidrop PicoIT software outputs report files in three formats:

- **Excel Compatible XML format (*.xml):** This Excel-specific XML (eXtensible Markup Language) file contains useful details from running a protocol in a file format designed to be opened and viewed in Microsoft Excel. This file includes formatting (page tabs and cell formatting) to improve direct reading by the user. The tabs within this format are described extensively within this appendix.

- **Comma Separated Values (*.csv):** This contains the same information as the Excel XML format, but in a comma delimited format. This format may be more useful for importing protocol information into a LIMS system.

- **PDF (*.pdf):** This contains the same information as the Excel XML format, but in the pdf format. It is also possible to include signature lines and digitally sign reports using a certificate.

- **QuantStudio™ Design & Analysis (*.DA.csv):** This report format can be imported to Applied Biosystems QuantStudio Design & Analysis software. It is transferring information from Multidrop PicoIT dispensing protocol for qPCR run.

- **Data XML (*.DATA.xml):** This contains the same information as the Excel XML format, but is in generic XML. This format may be more useful for importing protocol information into a LIMS system.

Example (Excel Compatible XML)
Below is an illustrative example of a protocol that contains multiple fluids, normalization, and randomization. This example is the basis for the report files used throughout the remainder of this Appendix.

Descriptions of the regions of this protocol follow below:
1. **Non-Randomized Region**: This region of the protocol (A1-C12) is non-randomized.

2. **Normalized Region**: This region of the protocol (B1-B6) is normalized to the level of the highest volume well within the region.

3. **Two-fluid synergy**: This region of the protocol (A7-C9) contains a two-fluid synergy experiment.

4. **Three-fluid synergy**: This region of the protocol (A10-C12) contains a three-fluid synergy experiment that has been normalized to the highest volume well.

5. **Randomized Region**: This region of the protocol (E1-G12) is a randomized replicate of the wells shown in region 1 (A1-C12).

**Summary**

The Summary tab shows summary information for the protocol. This includes the file location of the protocol, start and finish time for the protocol, and key protocol information, including the dispense order for the normalization fluid (if used), and the settings for plate shaking (if used).

<table>
<thead>
<tr>
<th>Protocol</th>
<th>C:\Users\User\Documents\Dispense\Protocols\Reports\Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Started</td>
<td>Wednesday, June 18, 2014 2:53:22 PM</td>
</tr>
<tr>
<td>Completed</td>
<td>Wednesday, June 18, 2014 2:55:29 PM</td>
</tr>
</tbody>
</table>

**Fluids**

The Fluids tab shows details of the fluids used within the protocol. The top section contains information about all fluids defined within the protocol, including fluids marked as No Dispense. This section also
includes the fluid load volume requested by the Multidrop PicoIT software, and the dispensed volume.

The second section contains information about the dispense heads and cassettes used within the protocol, including the mapping of fluid to dispense head number. In cases when a fluid is used in more than a single dispense head, the requested load volume and dispensed volume are shown by dispense head.

### Plates

The Plates tab shows information for all plates in the protocol, including plates marked as Don’t Dispense. This includes plate number (which corresponds to the order of the plates within the protocol) and the defined assay volume of the plate. The **Plate name** is defined by the user within the protocol setup, while the **Plate ID** is defined by the user within the run process the first time the plate is loaded onto the instrument.

### Tabular

The Tabular tab shows dispensed concentration and volume in a columnar format. Each **well** within a protocol has a single row in the tab, and each fluid within the protocol has a single concentration column and a single volume column. Composite concentration and volume information columns are also found within the tab. Composite information column headers are colored black, whereas individual-fluid column headers are colored with their corresponding fluid color. Well locations are shown in alphanumerical (“A5”, “C12”) as well as numeric row and column formats. Rows are sorted by plate number, then dispensed row, and then dispensed column. Descriptions of the regions of this report file tab follow below:

1. **Composite fluid name** – When a well contains a single fluid with or without a normalization fluid, the composite ‘Fluid Name’ cell
for that row will contain that fluid name and will be colored with the fluid color. When a well contains more than a single fluid (not including normalization fluid), the composite ‘Fluid Name’ cell for that row will be named ‘N fluids’, where N is the number of fluids within that well. The cell will be colored white.

2. **Composite concentration** – When a well contains a single fluid with or without a normalization fluid, the composite ‘Concentration’ cell for that row will contain the concentration of that single fluid and will be colored with the fluid color. When a well contains more than a single fluid (not including normalization fluid), the composite ‘Concentration’ cell for that row will be blank and will be colored white.

3. **Composite total volume** – When a well contains a single fluid without a normalization fluid, the composite ‘Total Volume’ cell for that row will contain the volume of that single fluid and will be colored with the fluid color. When a well contains more than a single fluid (including normalization fluid), the composite ‘Total Volume’ cell for that row will include the total volume, including the volume of the normalization fluid, and will be colored white.

4. **Composite volume** – When a well contains a single fluid without a normalization fluid, the composite ‘Volume’ cell for that row will contain the volume of that single fluid and will be colored with the fluid color. When a well contains more than a single fluid (including normalization fluid), the composite ‘Volume’ cell for that row will be blank and will be colored white.

5. **DMSO %** - Only DMSO fluids and DMSO normalization are included in this calculation.

**Tabular Detail**

The Tabular Detail tab shows dispensed concentration and volume in an alternative columnar format. Each dispense within a protocol has a single row in the tab, and there are single columns within the protocol for Dispensed Concentration and Dispensed Volume of each dispense. This tab may be more useful for pulling protocol dispense information into a LIMS system. Normalization fluids do not have a dispensed concentration. The fluid number, fluid name, cassette number, and dispensehead for each dispense are colored with their corresponding fluid color. Well locations are shown in alphanumeric (“A5”, “C12”) as well as numeric row and column formats. Rows are sorted by plate number, then dispensed row, and then dispensed column. In cases where there is a single fluid per well, each well will have a single row. In cases where there are multiple fluids per well, each well will have as many rows as it has fluids, including a separate row for the normalization fluid. In the example below, well A11 has four separate dispense events and four rows to correspond to the three fluids and the one normalization fluid.
The Tabular Detail tab contains a few other useful pieces of information highlighted below. Descriptions of these regions follow:

1. **Dispense head** – When the amount of any protocol fluids exceeds the maximum amount of fluid that can be loaded into a single dispensehead, dispensing of the fluid is split between two or more dispenseheads. The Multidrop PicoIT software distributes the required amount of fluid between these two or more dispenseheads approximately equally. Occasionally, this causes a transition between dispenseheads to occur within a single well. In this case, the report file will report the word ‘Multiple’ within the dispensehead column. The start time associated with these ‘split dispense’ events belongs to the first dispense event.

2. **NonRandom** columns provide a tool for re-sorting the dispensing information from a randomized-region of a protocol back to the original non-random configuration. In the example protocol, the wells in region 1 (A1-C12) are duplicated in region 5 (E1-G12) and then randomized. Once plate-reader data has been matched to the ‘Dispensed Concentration’ or the ‘Dispensed Volume’ columns, then the data can be re-sorted using the ‘NonRandom rows’ and ‘NonRandom col’ columns.

It should be noted that when manually analyzing randomized data, it can often be just as useful to match the report file rows to plate reader
output rows and then to sort first by fluid name and then by fluid concentration.

**Dispensed Conc**

The Dispensed Conc tab shows the dispensed concentration in each well in a spatially-representative plate format. This is done first in a composite section, and then in fluid-by-fluid sections. If a well in the composite section contains only a single fluid, that well is colored with the color code of that fluid. If a well in the composite section contains multiple fluids, the number of fluids dispensed in the well is indicated.

If a protocol contains a single plate, then the tab will be named ‘1 Dispensed Conc’. If a protocol contains multiple plates, then subsequent plates in the protocol will be named with the corresponding plate number, i.e. ‘2 Dispensed Conc, ‘3 Dispensed Conc’, etc.

<table>
<thead>
<tr>
<th>Fluid 1 (µM)</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>100</td>
<td>10.52</td>
<td>1.12</td>
<td>0.118</td>
<td>0.012</td>
<td>0.0013</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>196</td>
<td>10.52</td>
<td>1.12</td>
<td>0.118</td>
<td>0.012</td>
<td>0.0013</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>196</td>
<td>80</td>
<td>60</td>
<td>40</td>
<td>20</td>
<td>0.0013</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>196</td>
<td>0.0013</td>
<td>0.118</td>
<td>0.012</td>
<td>0.0013</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>196</td>
<td>0.118</td>
<td>0.012</td>
<td>0.0013</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>196</td>
<td>0.0013</td>
<td>0.118</td>
<td>0.012</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G</td>
<td>196</td>
<td>0.118</td>
<td>0.012</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H</td>
<td>196</td>
<td>0.0013</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Dispensed Volume**

The Dispensed Volume tab shows the dispensed volume in each well in a spatially-representative plate format. This is done first in a composite section, and then in fluid-by-fluid sections. If a well in the composite section contains only a single fluid, that well is colored with the color code of that fluid. If a well in the composite section contains multiple fluids, then that well is non-colored and contains the cumulative volume of all the fluids in the well. If a normalization fluid is used, the total volume reported in the composite section includes the volume of the normalization fluid.

If a protocol contains a single plate, then the tab will be named ‘1 Dispensed Volume’. If a protocol contains multiple plates, then subsequent plates in the protocol will be named with the corresponding plate number, i.e. ‘2 Dispensed Volume, ‘3 Dispensed Volume’, etc.
The Start Time tab shows the dispense start time for each well in a spatially-representative plate format for each plate within a protocol. This is done first in a composite section, and then in fluid-by-fluid sections. If a well in the composite section contains only a single fluid, that well is colored with the color code of that fluid. If a well in the composite section contains multiple fluids, then that well is non-colored and contains the starting dispense time of the first fluid dispensed into that well.

If a protocol contains a single plate, then the tab will be named ‘1 Start Time’. If a protocol contains multiple plates, then subsequent plates in the protocol will be named with the corresponding plate number, i.e. ‘2 Start Time’, ‘3 Start Time’, etc.
Events

The Events tab shows key event information for the protocol. This includes, start and finish time for the protocol, when plates and cassettes were loaded, when dispenseheads were filled with fluid, and when dispenseheads started and finished dispensing. The starting dispense time per dispensehead is shown in column A, while the ending dispense time is shown in column B.

<table>
<thead>
<tr>
<th>Time</th>
<th>Event Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2:53:22 PM</td>
<td>Started</td>
</tr>
<tr>
<td>2:53:23 PM</td>
<td>Loaded plate 1.</td>
</tr>
<tr>
<td>2:53:23 PM</td>
<td>Loaded cassette 1.</td>
</tr>
<tr>
<td>2:53:25 PM</td>
<td>Filled dispensehead 1 with 'Fluid 1'.</td>
</tr>
<tr>
<td>2:53:25 PM</td>
<td>Filled dispensehead 2 with 'Fluid 2'.</td>
</tr>
<tr>
<td>2:53:26 PM</td>
<td>Filled dispensehead 3 with 'Fluid 3'.</td>
</tr>
<tr>
<td>2:53:25 PM</td>
<td>'Fluid 1' dispensed from head 1.</td>
</tr>
<tr>
<td>2:53:27 PM</td>
<td>Filled dispensehead 4 with 'Fluid 3'.</td>
</tr>
<tr>
<td>2:53:27 PM</td>
<td>Filled dispensehead 5 with 'DMSO normalization'.</td>
</tr>
<tr>
<td>2:53:27 PM</td>
<td>'Fluid 2' dispensed from head 2.</td>
</tr>
<tr>
<td>2:53:28 PM</td>
<td>'Fluid 3' dispensed from head 3.</td>
</tr>
<tr>
<td>2:53:28 PM</td>
<td>'Fluid 3' dispensed from head 4.</td>
</tr>
<tr>
<td>2:53:29 PM</td>
<td>'DMSO normalization' dispensed from head 5.</td>
</tr>
<tr>
<td>2:53:29 PM</td>
<td>Completed</td>
</tr>
</tbody>
</table>
Chapter 11
Appendix B – Moving Data between the Multidrop PicoIT software and other programs

General copy and paste

Copying and pasting protocol data within the Multidrop PicoIT software and from the Multidrop PicoIT software to the clipboard is contextual, with two different modes depending on what is being copied and pasted:

- **Fluid list:** Copying and pasting fluids is available by right clicking on the Fluid list or through the Fluids section of the Advanced ribbon.
- **Well plate:** Copying and pasting wells is available by right clicking within the well plate, through the clipboard section of the Home ribbon, and through the global shortcuts (i.e. ctrl-C, ctrl-X, ctrl-V, etc.).

While this appendix illustrates moving protocol data between the Multidrop PicoIT software and Microsoft Excel, the techniques shown can be used to move between the Multidrop PicoIT software and other applications as well.

**Note** When pasting from Excel, the display format may limit the significant digits for numbers.

Fluid list copy and paste

Below is an illustrative example of a Fluid list with three fluids. Screen captures use the “Show More” feature of the fluid list (right-click on the list to change).
Appendix B – Moving Data between the Multidrop PicoIT software and other programs

Fluid list copy and paste

Figure 1 Example fluids list

- **Fluid Name**: For red fluid, this is ‘Fluid 1’.
- **Class**: For the blue fluid, this is ‘Aqueous + Brij 35’.
- **Stock Concentration and Units**: For red fluid, this is 10 mM; for the green fluid, this is 20 µg/mL; for the blue fluid there is no stock concentration.
- **Source Plate**: For red fluid, this is ‘Source Plate1’ (hover the mouse over fluid to see details). This is the optional, user provided, name of the stock compound source plate or vial.
- **Source Well**: For red fluid, this is ‘B17’. This is the optional, user provided, well location within a source plate.
- **Dispense by Concentration/Volume**: The red and green fluids are dispensed by concentration; the blue fluids is dispensed by volume (hover the mouse over the icon to see description).
- **Dispense/No Dispense**: For red fluid, this is ‘Dispense’; for the green fluid, this is ‘No Dispense’ (hover the mouse over the icon to see description). A ‘Dispense’ fluid will be dispensed during the running of the protocol; a ‘No Dispense’ fluid will not be dispensed.

Clicking **Copy All Fluids** will copy all of the contents of the Fluid list to the clipboard. Pasting the information from the fluids list in Figure 1 into Microsoft Excel yields the data shown in Figure 2. Each row corresponds to one fluid in the Fluid list and the rows are sorted in the order displayed in the Fluid list. Headers are included for reference, and they should not be selected when copying from an external application.

<table>
<thead>
<tr>
<th>Fluid name</th>
<th>Stock conc.</th>
<th>Stock conc. units</th>
<th>Class</th>
<th>Source plate</th>
<th>Source well</th>
<th>No Dispense</th>
<th>Dispense by Volume</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fluid 1</td>
<td>10 mM</td>
<td>DMSO</td>
<td>Source Plate1</td>
<td>B17</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fluid 2</td>
<td>20 µg/mL</td>
<td>DMSO</td>
<td>Mother Plate</td>
<td>G11</td>
<td>No Dispense</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fluid 3</td>
<td>aB</td>
<td>Daughter Plate</td>
<td>F9</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 2 Example fluids list pasted into Excel

Fluid information can be manipulated in another application and then pasted into the Multidrop PicoIT software using the **Paste Fluids** function on the **Advanced**, ribbon tab. When a fluid name is **unchanged**, the Multidrop PicoIT software recognizes the pasted information as an existing fluid, and other information associated with that fluid will be modified if necessary. For example, pasting the 3x7
array of cells shown in the left portion of Figure 3 yields the updated fluids list shown in the right portion of Figure 3. A few details follow:

- If the fluid names being pasted back into the Fluid list match the names already in the Fluid list, and the selection region includes other fields of the Fluid list, then these other fields are overwritten with the new values. If concentration (and units) or fluid class are blank, however, the existing fluid values will not be changed.
- Specify a fluid as ‘No dispense’ by including any character (any non-blank value) in the No Dispense column.
- Specify a fluid as ‘Dispense by volume’ by including any character (any non-blank value) in the Dispense by Volume column.

Since the fluid list was modified, the user is warned before Paste Fluids is completed.

Tip  Do not select column headings when pasting fluids from Excel.

Paste new fluids

When using the Paste fluid function, if a fluid has a name that is not already contained in the Fluid list, the Multidrop PicoIT software interprets the pasted information as belonging to a new fluid. In this case, the information associated with the new fluid is appended to the Fluid list. Pasting the 3x7 array of cells shown in the left portion of Figure 4 yields the updated Fluid list shown in the right portion of Figure 4.
Fluid list copy and paste

When a protocol is repeatedly used as a template, and only the fluids are changing between protocol runs, the fluids can be changed using the Replace fluids function. This allows fluid information to be replaced without modifying any well fluids associated with the fluids already in the Fluid list. When starting with the Fluid list on the left portion of Figure 5, copying the 2x1 array of cells shown in the center portion of Figure 5 and using the Replace fluids function yields the Fluid list shown on the right portion of Figure 5.
Appendix B – Moving Data between the Multidrop PicoIT software and other programs

Well plate copy and paste

Below is an illustrative example of a well plate grid from a protocol. This protocol is used as a starting point for the following examples.

![Well plate grid example]

Clicking **Copy Wells** will copy the contents of the selected wells to the clipboard. Pasting this information into Microsoft Excel yields data like that shown in Figure 6. For each fluid in the plate, a representative well plate template with column and row headers is created. For fluids dispensed by Volume, the values pasted in each cell within the template correspond to the volume of the respective fluid in current protocol units. For fluids dispensed by Concentration, the values pasted in each cell within the template correspond to the concentration of the respective fluid in current protocol units. In the row above each fluid template is information for that fluid, specifically (from left to right): Fluid name, Stock Concentration and Units, Class, Source Plate, Source Well, No Dispense, and Dispense Mode. A few additional details follow:

- **Copy Wells** does not function when viewing randomized.
- Normalization information will not be copied or pasted to an external application (e.g. Microsoft Excel).
- Randomization information is not copied to the clipboard.
- **Copy Wells** only copies the selected wells – it does not copy all the well contents of the plate (**Copy All Wells** copies all the well contents of the plate).
Appendix B – Moving Data between the Multidrop PicoIT software and other programs

Well plate copy and paste

Figure 6  Output of Copy Wells function after pasting into Microsoft Excel

Paste structured well information

Well information can be manipulated in Microsoft Excel and then pasted into the Multidrop PicoIT software using the Paste function. Values in each cell are interpreted using the units in the upper-left corner of the fluid headers. The units may be concentration or volume units.

Note  To paste raw concentration or volume values, see the Paste unstructured well information section.

A few additional details:

- If the entire well plate template region is copied from Microsoft Excel onto the clipboard, including the fluid header row above each fluid region, then the Paste function in the Multidrop PicoIT software recognizes the template as being a plate and displays the following message:
• If Replace all fluids in the plate is checked, then all existing well contents on the plate are deleted and replaced with the new well values.

• If Replace all fluids in the plate is unchecked, then existing well contents on the plate for fluids in the clipboard are replaced, but existing well contents for fluids not on the clipboard remain. In this case, if a well already contains Fluid 1, for example, and the paste region for that well contains Fluid 8, the resulting well will contain both Fluid 1 and Fluid 8.

• If only a portion of a well plate is selected when copying from Microsoft Excel, then only the wells within the selected region will be written upon pasting into the Multidrop PicoIT software. Wells outside of the selected region will not be overwritten. For example, if only the upper 5x3 grid of wells from the example protocol shown in the left half of Figure 7 are pasted back into the protocol onto a blank plate, then the message shown in the right half of Figure 7 is shown.

<table>
<thead>
<tr>
<th>Fluid 1</th>
<th>10 mM</th>
<th>DMSO</th>
</tr>
</thead>
<tbody>
<tr>
<td>µM</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>B</td>
<td>100</td>
<td>10.53874</td>
</tr>
<tr>
<td>C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>100</td>
<td>10.53874</td>
</tr>
</tbody>
</table>

Paste warning

Plate size on Clipboard (5 rows, 3 columns) does not match the current plate size.

Continue to Paste?

Continue  Cancel

Figure 7 Paste a partial plate

Clicking continue yields the plate shown below:
Appendix B – Moving Data between the Multidrop PicoIT software and other programs

Well plate copy and paste

- Only the fluid name is required in the row above the template header, all other fluid information is optional.
- Changing the fluid information in the row above the template header will modify the values in the Fluid list. Empty cells in the fluid-information row will be ignored.

Note: Empty fluid information cells are treated differently than they are when pasting into the Fluid list (Paste fluid information to modify the existing Fluid list).

Modify well information example

In this example, the original data in Figure 6 has been modified as shown in Figure 8. Rows of fluid Fluid 1 and Fluid 2 have been swapped in columns 1-6. In addition, another copy of the Fluid 1 columns 1-6 has been added to row H. Only Fluids 1 and 2 (not Fluid 3) are copied to the clipboard and pasted into the Multidrop PicoIT software.

Figure 8 Modified Data in Microsoft Excel

Figure 9 shows the result in the Multidrop PicoIT software, with the original plate in the left portion of the figure, and the modified plate in
the right portion of the figure. In addition to seeing that the red and green fluids within columns 1-6 have changed places, it can be seen that the original randomization definitions are unchanged, and the normalization and blue fluids have been eliminated.

![Original and then modified plate in Multidrop PicoIT software](image)

### Paste unstructured well information

Well information can be created directly in Microsoft Excel without template information and then pasted into the Multidrop PicoIT software using the Paste function. When unstructured well information is pasted, the user will be prompted by the Multidrop PicoIT software to identify what fluid to associate with the pasted wells. Pasting will be done in current mode and units for the selected fluid.

In this example, the following array of values is created in Microsoft Excel and copied to the clipboard:

```
[values]
```
When a destination location is selected within a well plate in the Main Operating Window and either Paste or Paste Special is selected, the Multidrop PicoIT software will respond with the following prompt and the user must select a fluid from the drop down list to paste.

- If Replace all fluids in the paste region is checked, then all existing well contents are replaced with the new well values in the paste region.
- If Transpose rows and columns is checked, the rows and columns are transposed during paste.

If no fluids exist within the Fluid list, pasting of unstructured well information is not allowed. In this example, well B2 is identified as the destination location, and Fluid 1 is identified as the Paste Fluid. Figure 10 shows the result in the protocol.
Chapter 12
Appendix C - Matching randomized layout to plate reader data

Once a randomized protocol has been created and run on the Multidrop Pico dispenser, the dispensing profile needs to be joined with corresponding plate-reader data for analysis. The following shows an example of this procedure.

**Tip** The Data Merge utility, included in the Multidrop PicoIT software install package, can also be used to combine plate reader data with dispense data from a report file.

**Step 1: Create and Run a Randomized Protocol**

*Figure 1* shows a typical titration protocol before and after it has been randomized. The randomized protocol is run on the Multidrop Pico dispenser and the resultant plates are read on a plate reader.
Appendix C - Matching randomized layout to plate reader data

Step 2: Read results on plate reader

Note This example assumes that empty wells are included in the “Tabular Detail” tab of the report (see Reports settings). Alternately, the “Tabular” report tab could be used.

Figure 1 Original Non-Randomized Protocol [left]; Randomized Protocol [right]

Step 2: Read results on plate reader

Figure 2 shows typical results from a plate reader. When a plate reader has the option, it is preferable to use columnar output format, in other words with data sorted A1-H12 (96 plate) or A1-P24 (384 plate) in a single column. Save the plate reader data to an Excel or CSV file for use in Step 4.
Step 3: Open the Multidrop PicoIT *.xml report file in Excel

Once the *.xml report file has been opened, go to the “Tabular Detail” tab to find the dispense data arranged with each dispense assigned to a row. Note that rows are ordered A1-H12 (96 plate) or A1-P24 (384 plate) and that in the example below, the dispensed volumes are found in Column ‘O’, while the corresponding concentrations are found in Column ‘N’.

Step 4: Paste reader Data into the *.xml file.

Paste the plate reader data into the ‘Tabular Detail’ tab of the *.xml Multidrop PicoIT report file. Because both data sets are ordered A1-H12, the plate reader wells are now matched with the report file wells. The pasted wells are highlighted in yellow for visibility.
Step 5: Re-sort data by Fluid name and then “Dispensed concentration”

To get the data sorted by fluid name and then in order of concentration, the Excel ‘data sort’ function can be employed, as shown in Figure 5. The resultant data after sorting can be seen in Figure 6.

Figure 4   Dispense data with plate reader data pasted in

Figure 5   Data sort function in Excel to get randomized data into a useful sequence

Figure 6   Data set now sorted by Fluid name and then by dispensed concentration
If plate reader data is output in spatial plate-layout format, rather than columnar format, several templates are available to enable the conversion to columnar format:

- Spatial Plate to Columnar Template 96: For analyzing 96-well plates.
- Spatial Plate to Columnar Template 384: For analyzing 384-well plates.
- Spatial Plate to Columnar Template 1536: For analyzing 1536-well plates.

These templates are found in the Multidrop PicoIT software folder within “My Documents.” Each template has an “Input SpatialFormat *” tab, and an “Output ColumnarFormat *” tab. Reader data in spatial plate-layout format can be pasted into the Input tab, and then the same plate data in columnar format can be copied out of the output tab. **Figure 7** shows an example of a 384-plate template for inputting spatial plate-layout data. **Figure 8** shows an example of the same data in columnar output format. Once data is arranged in columnar format, it can then be matched to the Multidrop PicoIT software report file as shown below.

![Figure 7](image_url)

**Figure 7**  Sample data input in spatial-plate format
Appendix C - Matching randomized layout to plate reader data

Alternative methods for sorting

Note in Figure 6 that several other columns may sometimes be useful as an alternative method for sorting dispensing data after it has been paired to plate-reader data. Specifically, Columns F (Non-Random Row#), Column G (Non-Random Row), and/or Column H (Non-Random Column) can be used to rearrange randomized plate dispense and plate reader data back into the original non-randomized layout.
Chapter 13
Appendix D – Concentration Calculations

With DMSO and dilute aqueous solutions, volume to achieve a desired concentration may be calculated without including dispensed volumes; this is a negligible error since the added volumes from the Multidrop Pico dispenser are small relative to the total assay volume. However, there are cases where the entire assay may be dispensed by the Multidrop Pico dispenser. For example, in miniaturized well-plate based PCR, the volumes added by the Multidrop Pico dispenser are usually significant and should not be ignored in concentration calculations.

Each protocol plate has a specified additional volume. This additional volume is the amount of fluid that the user places in the well in addition to dispensed fluids. The total assay volume will be this additional volume plus volume dispensed by the Multidrop Pico dispenser. In some cases – such as miniaturized PCR where master mix, primer and sample are all from the Multidrop Pico dispenser – the additional volume for the plate should be set to zero.

Calculation of true concentration must be accomplished iteratively since adding fluid with the Multidrop Pico dispenser changes the overall assay volume which in turn changes concentrations. Calculation of concentration utilizes well volumes that include both dispensed fluids and user-added Additional volume (see Plate-associated information).

Since concentrations are calculated iteratively, there can be conditions created where concentrations cannot be calculated. For example, it is possible to Normalize wells using Normalize to % of total volume with a percentage high enough where a solution does not exist as concentrations are iteratively recalculated. If this occurs, a warning is displayed for affected wells.
Chapter 14
Appendix E – Dispense Specifications

DMSO dispensing

Selected dispensehead cassette specifications for DMSO dispensing:

- 70-100% DMSO.
- Nanoparticles < 1 micron in diameter in stable suspension at concentrations ≤ 0.5%.
- There are additional considerations for small molecule and biomolecule dispensing. See Dispensing Considerations for detail.

<table>
<thead>
<tr>
<th>Standard-volume cassette</th>
<th>High-volume cassette</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum dispense volume per dispensehead</td>
<td>10 µL</td>
</tr>
<tr>
<td>Maximum dispense volume per dispensehead – normalization and bulk dispense</td>
<td>20 µL</td>
</tr>
<tr>
<td>Minimum dispense volume</td>
<td>13 pL</td>
</tr>
<tr>
<td>Minimum dispense volume – normalization and bulk dispense</td>
<td>1 nL</td>
</tr>
<tr>
<td>Minimum fill volume</td>
<td>2 µL</td>
</tr>
<tr>
<td>Maximum dispense volume – each fluid per well</td>
<td>10 µL</td>
</tr>
<tr>
<td>Dispense increment (per well)</td>
<td>400 pL for &gt; 3.6 nL</td>
</tr>
<tr>
<td></td>
<td>20 pL for 17 pL - 3.6 nL</td>
</tr>
<tr>
<td></td>
<td>13 pL for &lt; 17 pL</td>
</tr>
<tr>
<td>Recommended microplate limit per protocol</td>
<td>32</td>
</tr>
</tbody>
</table>

Notes:

1 – Bulk Dispense is defined as when all dispensed volumes for a fluid are 1nL or greater.
Aqueous dispensing

Selected dispensehead cassette specifications for aqueous dispensing, including surfactant and glycerol:

- Aqueous solutions require the addition of surfactant to enable priming by reducing surface tension. Refer to Table 1 for recommended surfactants and concentration ranges. In addition, the presence or absence of glycerol impacts dispensing – there are separate fluid classes dependent on glycerol content.
- Master mix fluids (Table 2) do not require surfactant.
- Total buffer components < 150mM.
- Nanoparticles < 1 micron in diameter in stable suspension at concentrations ≤ 0.5% by weight.
- Types of biomolecules which either can or cannot be dispensed are listed in Table 3.
- There are additional considerations for small molecule and biomolecule dispensing. See Dispensing Considerations for detail.
### Appendix E – Dispense Specifications

#### Aqueous dispensing

<table>
<thead>
<tr>
<th>Standard-volume cassette</th>
<th>High-volume cassette</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum dispense volume per dispensehead</td>
<td>10 µL</td>
</tr>
<tr>
<td>Maximum dispense volume per dispensehead – normalization and bulk dispense</td>
<td>20 µL</td>
</tr>
<tr>
<td>Minimum dispense volume</td>
<td>11 pL</td>
</tr>
<tr>
<td>Minimum dispense volume – normalization and bulk dispense</td>
<td>1 nL</td>
</tr>
<tr>
<td>Minimum fill volume</td>
<td>4 µL</td>
</tr>
<tr>
<td>Maximum dispense volume – each fluid per well</td>
<td>10 µL</td>
</tr>
<tr>
<td>Dispense increment (per well) without glycerol</td>
<td>560 pL for &gt; 3.6 nL</td>
</tr>
<tr>
<td></td>
<td>11 pL for ≤ 3.6 nL</td>
</tr>
<tr>
<td></td>
<td>n/a for &lt; 1 nL</td>
</tr>
<tr>
<td>Dispense increment (per well) with glycerol</td>
<td>600 pL for &gt; 3.6 nL</td>
</tr>
<tr>
<td></td>
<td>12 pL for ≤ 3.6 nL</td>
</tr>
<tr>
<td></td>
<td>n/a for &lt; 1 nL</td>
</tr>
<tr>
<td><strong>Recommended microplate limit per protocol</strong></td>
<td>1536 well or 4 plates</td>
</tr>
</tbody>
</table>

**Notes:**

1 – Bulk Dispense is defined as when all dispensed volumes for a fluid are 1 nL or greater.

2 – To minimize evaporation.

<table>
<thead>
<tr>
<th>Fluid Class</th>
<th>Surfactant</th>
<th>Surfactant Concentration</th>
<th>Glycerol</th>
</tr>
</thead>
<tbody>
<tr>
<td>a + B</td>
<td>Brij 35</td>
<td>0.1 %</td>
<td>0 - &lt;5%</td>
</tr>
<tr>
<td>a + B + g</td>
<td>Brij 35</td>
<td>0.1 %</td>
<td>5 - 20%</td>
</tr>
<tr>
<td>a + TX</td>
<td>Triton X100</td>
<td>0.1 %</td>
<td>0 - &lt;5%</td>
</tr>
<tr>
<td>a + TX + g</td>
<td>Triton X100</td>
<td>0.1 %</td>
<td>5 - 20%</td>
</tr>
<tr>
<td>a + Tw</td>
<td>Tween 20</td>
<td>0.3%</td>
<td>0 - &lt;5%</td>
</tr>
<tr>
<td>a + Tw + g</td>
<td>Tween 20</td>
<td>0.3%</td>
<td>5 - 20%</td>
</tr>
</tbody>
</table>

**Table 1** Aqueous fluid classes
Dispensing Considerations

The Multidrop PicoIT software will use one of several modes to dispense your fluids. If you have high-volume cassettes available, there are three potential modes.

- Use high-volume cassettes with a maximum dispense volume of 200 µL.
- Use standard-volume cassettes with a maximum dispense volume of 20 µL.
- Use standard-volume cassettes with a maximum dispense volume of 10 µL.

In deciding which mode will be used, the first consideration is the lowest volume to be dispensed into any well using that fluid. If any well has less than one nL, then standard-volume cassettes dispensing 10 µL will be used to ensure good reproducibility with low volume dispensing. If all wells for a fluid are greater than one nL, then Table 4 should be used. The more concentrated the fluid, the less total volume can be reliably dispensed. If the DMSO fluid class is used, or if the

---

### Table 2

<table>
<thead>
<tr>
<th>Master Mix</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brilliant II SYBR Green qRT-PCR 1-Step Master Mix</td>
</tr>
<tr>
<td>Brilliant III Ultra-Fast SYBR Green qPCR Master Mix</td>
</tr>
<tr>
<td>Brilliant Multiplex qPCR Master Mix</td>
</tr>
<tr>
<td>Fast SYBR Green Master Mix</td>
</tr>
<tr>
<td>iQ SYBR Green Supermix</td>
</tr>
<tr>
<td>Power SYBR Green PCR Master Mix</td>
</tr>
<tr>
<td>PowerUp SYBR Green Master Mix</td>
</tr>
<tr>
<td>QuantiTect SYBR Green PCR Master Mix</td>
</tr>
<tr>
<td>SsoAdvanced Universal SYBR Green Supermix</td>
</tr>
<tr>
<td>SYBR Select Master Mix</td>
</tr>
<tr>
<td>TaqMan Gene Expression Master Mix</td>
</tr>
<tr>
<td>TaqMan RNA-to-CT 1-Step Kit</td>
</tr>
<tr>
<td>TaqMan Universal PCR Master Mix</td>
</tr>
</tbody>
</table>

| Table 2 | Master mix list |

---

### Table 3

<table>
<thead>
<tr>
<th>Compatible</th>
<th>Non-Compatible</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enzymes &lt; 300kDa</td>
<td>Enzymes &gt; 300kDa</td>
</tr>
<tr>
<td>Antibodies</td>
<td>Cells</td>
</tr>
<tr>
<td>Peptides</td>
<td>Saliva</td>
</tr>
<tr>
<td>Oligos and labeled oligos</td>
<td>Whole blood</td>
</tr>
<tr>
<td>Lipids</td>
<td>Plasma</td>
</tr>
<tr>
<td>Small molecules such as ATP, ADP</td>
<td>Serum</td>
</tr>
<tr>
<td>PCR Master mix</td>
<td>DNA &lt; 10,000 base pairs</td>
</tr>
</tbody>
</table>

| Table 3 | Example compatible biomolecules |
biomolecule concentration is not entered in mg/mL, then the most economical option is used by the Multidrop Pico dispenser.

<table>
<thead>
<tr>
<th>Small Molecules</th>
<th>Biomolecules</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000 Da 10 mM</td>
<td>300 kDa or 10,000 base pairs 3 mg/mL</td>
</tr>
<tr>
<td>1000 Da 10 mM</td>
<td>300 kDa or 10,000 base pairs 1 mg/mL</td>
</tr>
<tr>
<td>1000 Da 10 mM</td>
<td>300 kDa or 10,000 base pairs 0.3 mg/mL</td>
</tr>
</tbody>
</table>

Table 4 Dispense limits for small molecules and biomolecules

One final consideration is that high-volume cassettes have a greater dead volume than standard-volume cassettes due to the amount of stranded fluid in the large fill cup. If there is an extremely precious fluid, deselect “Use high-volume cassettes” at the start of the protocol run.
Chapter 15
Appendix F – Best Practices for Dispensing

All fluids
To ensure optimum performance, it is recommended that the first plate using a fluid includes a well with volume of 30nL or greater; this ensures the dispensehead is fully ready to dispense other much smaller volumes. Since plate dispense order can vary, it is recommended that all plates follow this recommendation. If your assay design cannot tolerate a dispense volume greater than 30nL, consider dedicating one “scrap” well on each plate to a larger dispense volume. This same well can be used for all fluids on the plate.

DMSO based fluids
- Although very large numbers of fluids and plates are allowed, it is recommended that designs of fewer than 100 fluids and 32 plates are used to reduce user error and to speed up the display processes of the Multidrop PicoIT software.
- DMSO fluids with only small molecules less than 1000 Daltons at concentrations no more than 10mM are recommended to be dispensed with the Multidrop Pico dispenser.
- If prefilling the dispenseheads with fluids outside of the Multidrop Pico dispenser, for example using a robotic system, minimize the time between filling and dispensing. It is recommended that prefilled dispenseheads with DMSO based fluids be used within 30 minutes of filling.
- During the Run Protocol operation, it is recommended that the Multidrop Pico dispenser not to be paused for longer than 15 minutes prior to resuming while using DMSO based fluids.

Aqueous based fluids
- The recommended limits for aqueous based fluids are shown when the mouse is moved in the Fluid Class drop down in the Fluid Edit dialog. For all aqueous fluids it is recommended that:
  - Small molecule compounds be less than 1000 Daltons and be present at no more than 10mM concentration.
  - Biomolecules be less than 300kDa or 10,000 base pairs and be present in total at no more than 3mg/mL concentration.
  - Glycerol levels be within the fluid class guidelines of either 0 - <5% or 5 - 20%.
- The best practices noted below are due to the high evaporation rate of aqueous fluids relative to DMSO:
• A limitation to the maximum number of plates in an aqueous fluid protocol has been enabled. The limit is 1536 wells or 4 plates.
• The amount of aqueous fluid that the user is requested to add to each dispensehead is greater than that requested for DMSO fluids, even when the amount to be actually dispensed is the same. In addition, the minimum volume requested for the fill is 4\(\mu\)L for aqueous fluids as opposed to a 2\(\mu\)L minimum requested volume for DMSO fluids. The dispensed volume for each fluid in the protocol is listed in the Fluids List, and the amount to fill into the dispensehead is given during Run Protocol.
• Fill dispenseheads with only the amount of aqueous fluids requested at the time of use during Run Protocol. It is not recommended to overfill aqueous fluids in any dispensehead.
• Fill dispenseheads with aqueous fluids at the time of use during Run Protocol. It is recommended that dispenseheads not be prefilled offline with aqueous based fluids.
• During the Run Protocol operation, it is recommended that the Multidrop Pico dispenser not to be paused while using aqueous based fluids.
• Shaking after each dispensehead is not recommended for aqueous fluids.

Deep Well Plates

As distance between the dispense cassette and the target surface increases, dispense placement variation also increases. For this reason, it is best to minimize the dispense distance. When dispensing into deep well plates, it is recommended to dispense into pre-filled plates.